
 

1 
 

 

 

ΠΑΝΕΠΙΣΤΗΜΙΟ ΘΕΣΣΑΛΙΑΣ 

ΠΟΛΥΤΕΧΝΙΚΗ ΣΧΟΛΗ 

ΤΜΗΜΑ ΜΗΧΑΝΙΚΩΝ ΧΩΡΟΤΑΞΙΑΣ, ΠΟΛΕΟΔΟΜΙΑΣ ΚΑΙ    ΠΕΡΙΦΕΡΕΙΑΚΗΣ 

ΑΝΑΠΤΥΞΗΣ 

ΠΜΣ «Χωρική Ανάλυση και Διαχείριση Περιβάλλοντος» 

 

 

ΜΕΤΑΠΤΥΧΙΑΚΗ ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ 

 

 

 

 

 

ΕΠΙΒΛΕΠΩΝ ΚΑΘΗΓΗΤΗΣ:  ΚΩΝΣΤΑΝΤΙΝΟΣ  ΠΕΡΑΚΗΣ 

 

Τριμελής  Επιτροπή : 

 

Κωνσταντίνος  Περάκης 

Όλγα Χριστοπούλου 

Δημήτριος  Σταθάκης 

 

   Στυλιανός   Καραπουρναλίδης 

Δασολόγος 

 

Βόλος  2018 

 

ΑΠΟΤΥΠΩΣΗ ΤΩΝ ΚΑΜΕΝΩΝ ΕΚΤΑΣΕΩΝ ΤΗΣ ΝΗΣΟΥ 

ΧΙΟΥ,  

ΑΠΟ ΤΗΝ  ΠΥΡΚΑΓΙΑ ΤΗΣ  25-07-2016, ΜΕ ΧΡΗΣΗ 

ΔΟΡΥΦΟΡΙΚΩΝ ΕΙΚΟΝΩΝ ΚΑΙ ΓΕΩΓΡΑΦΙΚΩΝ 

ΣΥΣΤΗΜΑΤΩΝ ΠΛΗΡΟΦΟΡΙΩΝ 

Institutional Repository - Library & Information Centre - University of Thessaly
03/06/2024 03:54:29 EEST - 3.15.15.125



 

2 
 

ΕΥΧΑΡΙΣΤΙΕΣ 

 

Η παρούσα εργασία σηματοδοτεί την ολοκλήρωση των μεταπτυχιακών σπουδών μου στο 

ΠΜΣ «Χωρική Ανάλυση και Διαχείριση Περιβάλλοντος» της Πολυτεχνικής Σχολής του 

Πανεπιστημίου Θεσσαλίας και την εμβάθυνση των γνώσεών μου σε θέματα χωρικής ανάλυσης 

και διαχείρισης του περιβάλλοντος, καθώς και τον συνδυασμό αυτών για την εξεύρεση  λύσεων 

σε περιβαλλοντικά προβλήματα. 

Θα ήθελα να εκφράσω τις θερμές ευχαριστίες στο Π.Μ.Σ. και σε όλους τους καθηγητές, οι 

οποίοι με την αμέριστη συμπαράστασή τους μου έδωσαν την ευκαιρία τώρα στη δύση της 

καριέρας μου, να  ολοκληρώσω τις μεταπτυχιακές σπουδές μου. 

Ιδιαίτερα ευχαριστώ τον κ, Ιωάννη Φαρασλή ο οποίος, με καθοδήγησε κατά τη διάρκεια 

συγγραφής της διπλωματικής εργασίας μου. 

Επίσης ευχαριστώ την Αποκεντρωμένη Διοίκηση Αιγαίου για την διευκόλυνση που μου 

παρείχε για την παρακολούθηση των μαθημάτων και την διάθεση της δορυφορικής εικόνας 

καθώς και το Τμήμα Χαρτογράφησης και Δασολογίου της Γενικής Διεύθυνσης του ΥΠΕΝ, για 

την χορήγηση του Χάρτη βλάστησης Ν. Χίου. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Institutional Repository - Library & Information Centre - University of Thessaly
03/06/2024 03:54:29 EEST - 3.15.15.125



 

3 
 

                                                          ΠΕΡΙΛΗΨΗ 

Η Τηλεπισκόπηση και  τα Γεωγραφικά Συστήματα Πληροφοριών (GIS), σήμερα είναι τα 

ποιό σύγχρονα και αποτελεσματικά εργαλεία μελέτης, καταγραφής και αποτύπωσης της 

επιφάνειας του πλανήτη, για την αποτύπωση και χαρτογράφηση της βλάστησης, των υδάτινων 

και των άλλων φυσικών πόρων, καθώς και τις μεταβολές τους στην μονάδα του χρόνου. Ο 

συνδυασμός των δύο αυτών εργαλείων είναι ικανός για τη λεπτομερή αποτύπωση και των 

καμένων εκτάσεων, με την βοήθεια της οποίας στην συνέχεια θα γίνει η αποτίμηση των 

επιπτώσεων των πυρκαγιών και θα αποτελέσει το εργαλείο για την λήψη αποφάσεων ως προς 

τις ενέργειες που απαιτούνται για την άρση των δυσμενών των επιπτώσεων των πυρκαγιών στο 

περιβάλλον. Επίσης θα βοηθήσουν και την εξέταση των αλλαγών στη χρήση/κάλυψη γης πριν 

και μετά από μια πυρκαγιά. 

Η παρατήρηση της γης από το διάστημα αποτελεί, τα τελευταία χρόνια, σημαντικό εργαλείο 

για τη μελέτη του φυσικού περιβάλλοντος και ιδιαίτερα την παρατήρηση, ανίχνευση, διαχείριση 

και μελέτη των φυσικών καταστροφών (Φείδας & Καρτάλης, 2006, Αρχές και εφαρμογές της 

δορυφορικής τηλεπισκόπησης). 

Η περιοχή μελέτης είναι η νήσος Χίος και συγκεκριμένα η περιοχή που επλήγη από την 

μεγάλη πυρκαγιά της 25 Ιουλίου 2016 στο νησί, με αποτέλεσμα να αποτεφρωθούν περίπου 

40.000 στρ. πευκοδάσους, βοσκοτόπων, μαστιχόδεντρων και ελαιόδεντρων.  

Η μεθοδολογία στηρίχτηκε στην προμήθεια και επεξεργασία των δορυφορικών εικόνων, 

προκειμένου να βελτιωθεί η ευκρίνειά τους και η ποιότητά τους και στη συνέχεια με χρήση 

κατάλληλου λογισμικού να παραχθούν χάρτες, έτσι ώστε να είναι ευκολότερη η χρήση και 

περαιτέρω επεξεργασία τους από τα Γεωγραφικά Συστήματα Πληροφοριών, με τη βοήθεια των 

οποίων δημιουργήθηκαν και οι τελικοί χάρτες απεικόνισης της καμένης έκτασης. 

Τα αποτελέσματα από την επεξεργασία των δορυφορικών δεδομένων  κατέδειξαν την   

ύπαρξη   περιοχών οι οποίες υπέστησαν ολική καταστροφή από την πυρκαγιά και επομένως είναι 

ευαίσθητες   στην   εδαφική διάβρωση αλλά και τις πλημμύρες. Στις περιοχές αυτές επιβάλλεται 

άμεσα η εκτέλεση αντιπλημμυρικών έργων επειδή δεν υπάρχει επαρκής πλέον βλάστηση για να 

συγκρατήσει το έδαφος και να το προστατέψει από την διάβρωση. 

 

Λέξεις κλειδιά:  

Remote sensing,   fire detection,   Geographical  Information Systems, wildfires NDVI, NBR. 
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ABSTRACT 

 

Remote Sensing and Geographical Information Systems (G.I.S.) today are the most modern 

and effective tools for recording and plotting the Earth's surface, for the mapping and mapping of 

vegetation, water and other natural resources, as well as their temporal changes. The combination 

of these two tools is capable of detailed capture and burned areas, which will then help assess the 

impact of fires and help in deciding on the actions required to remove the adverse effects of fires 

on environment. They will also help to examine changes in land use / cover before and after a 

fire. The study area is the island of Chios, namely the region that suffered from the great fire of 

July 25, 2016 on the island, resulting in about 4,000 hectars of pine forests, pastures, mastic trees 

and olive trees. The methodology was based on the sourcing and processing of satellite images in 

order to improve their image and quality and then make maps so as to make it easier for them to 

be further processed by the Geographical Information Systems, final imaging maps of the burnt 

area. The results from the processing of satellite data have demonstrated the existence of areas 

that have been totally destroyed by the fire and are therefore susceptible to soil erosion and 

floods. These areas are directly required to carry out flood protection works, because there is 

insufficient vegetation to contain the soil and protect it from erosion. 

 

Key Words:  

Remote sensing,  fire detection, Geographical Information Systems, wildfires. NDVI,  NBR. 
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ΕΙΣΑΓΩΓΗ 

Η τηλεπισκόπηση και τα γεωγραφικά πληροφοριακά συστήματα πληροφοριών αποτελούν 

πολύ σημαντικά εργαλεία για την καταγραφή και αποτύπωση της επιφανείας του πλανήτη μας, 

την καταγραφή των φυσικών πόρων όπως, νερά, βλάστησης, λόγω της έντονης ανάκλασης ή 

απορρόφησης από αυτές της ορατής και υπέρυθρης ακτινοβολίας.  

Με κατάλληλη μεθοδολογία μπορούν να αποτυπωθούν οι καμένες εκτάσεις λόγω της 

καταστροφής της βλάστησης η οποία πλέον αντανακλά λιγότερη υπέρυθρη ακτινοβολία και 

απορροφά άλλα μήκη κύματος. 

Η περιοχή που μελετούμε είναι η Χίος και πιο συγκεκριμένα η περιοχή των Μαστιχοχωρίων 

που επλήγη από την καταστροφική πυρκαγιά στις 25 Ιουλίου 2016, με αποτέλεσμα να 

αποτεφρωθούν χιλιάδες στρέμματα δάσους, δασικής έκτασης, χορτολιβαδικών εκτάσεων, 

ελαιοδένδρων, μαστιχόδενδρων και αγροτικών καλλιεργειών. Για τη χαρτογράφηση της καμένης 

έκτασης χρησιμοποιήθηκαν δορυφορικές εικόνες Sentinel-2  (χωρικής διακριτικής ικανότητας 10 

μέτρων). 

 

ΣΚΟΠΟΣ 

Σκοπός και αντικείμενο της διπλωματικής εργασίας είναι να αναδείξει την χρησιμότητα των 

δορυφορικών εικόνων και την χρησιμότητά τους στην ταχεία χαρτογράφηση των καμένων 

περιοχών. Ειδικά η εργασία αυτή ενασχολείται με την καταστροφική πυρκαγιά της 25-07-2016 

στο νησί της Χίου προκειμένου να βγουν χρήσιμα συμπεράσματα για την μείωση των δυσμενών 

επιπτώσεων στο περιβάλλον. 

Τα αποτελέσματα της ανάλυσης της πυρκαγιάς αναδεικνύουν την χρησιμότητα των 

δορυφορικών δεδομένων  για τον υπολογισμό των επιπτώσεων της πυρκαγιάς στο περιβάλλον 

και στη λήψη αποφάσεων ως προς τις ενέργειες που απαιτούνται μετά την πυρκαγιά, για την 

προστασία του περιβάλλοντος από διάβρωση του εδάφους και πλημμύρες. 

Η παρούσα μεταπτυχιακή  διπλωματική εργασία προσπαθεί να απαντήσει στα ερωτήματα: 

Πως γίνεται η αναζήτηση, προμήθεια και επεξεργασία δορυφορικών εικόνων; Με ποιά 

λογισμικά γίνεται η επεξεργασία τους; Πόσο αξιόπιστα και τι ακρίβεια παρέχουν σε σχέση με τις 

κοινές μεθόδους και άλλες ανάλογες εργασίες; Σε τι βαθμό θα βοηθήσει τη δασική Υπηρεσία 

στην αποτελεσματική προστασία των  καμένων εκτάσεων; 
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Κεφάλαιο 1. ΘΕΩΡΗΤΙΚΟ ΠΛΑΙΣΙΟ 

 

1.1 Θεωρητικό πλαίσιο 

     Το θεωρητικό πλαίσιο στηρίχτηκε στα παρακάτω εργαλεία, τα οποία αναζητήθηκαν στην    

   βιβλιογραφία και αξιοποιήθηκαν κατάλληλα. 

1. Change detection analysis. 

2. Fire detection. 

3. Remote sensing. 

4. Remote sensing and fires. 

5. NDVI, NBR 

 

            

1.2  Τηλεπισκόπηση και Πυρκαγιές 

Η Τηλεπισκόπηση και τα Γεωγραφικά Πληροφοριακά Συστήματα (GIS) εξελίχθηκαν σε πολύ 

χρήσιμα εργαλεία για την ανίχνευση, τη χαρτογράφηση και παρακολούθηση  των πυρκαγιών, 

τον σχεδιασμό και την πρόληψη  από τις πυρκαγιές, την παρακολούθηση της αναγέννησης της 

βλάστησης μετά από πυρκαγιά, την εκτίμηση του αρνητικών επιπτώσεων στο περιβάλλον και 

τελικά να βοηθήσουν στην λήψη αποφάσεων για την εκτέλεση έργων πρόληψης των πυρκαγιών 

καθώς και αντιδιαβρωτικών-αντιπλημμυρικών έργων. 

Η τηλεπισκόπηση χρησιμοποιείται επίσης για την καταγραφή των κατηγοριών βλάστησης, στο 

σύνολο της καμένης έκτασης από δορυφορικές εικόνες, οι οποίες υπάρχουν στις βάσεις 

δεδομένων των δορυφόρων πριν και μετά την πυρκαγιά. Στη διεθνή βιβλιογραφία οι λέξεις 

κλειδιά που χρησιμοποιούνται για τον εντοπισμό των καμμένων εκτάσεων, καθώς και την 

ποσοστική και ποιοτική αξιολόγηή τους είναι: Firedetection, Remotesensing andfires, 

Changedetection analysis, NDVI, NBR. 

Τα πολυφασματικά δορυφορικά δεδομένα σήμερα αποτελούν ένα ιδιαίτερα χρήσιμο εργαλείο 

για τη χαρτογράφηση των δασικών πυρκαγιών. Συγκεκριμένα, οι φασματικές ζώνες, όπως η 

κοντινή υπέρυθρη ακτινοβολία (nearinfrared), η μέση υπέρυθρη ακτινοβολία (mid-infrared) και 

η θερμική υπέρυθρη ακτινοβολία (thermalinfrared) είναι πολύ ευαίσθητες στις αλλαγές της 

ανακλώμενης ακτινοβολίας από τους νεκρούς ή ζωντανούς ιστούς των φυτών, που επιφέρει μια 

πυρκαγιά, ανιχνεύοντας έτσι με μεγάλη αξιοπιστία τις καμένες περιοχές, (2ο Συνέδριο 
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Γεωγραφικών Πληροφοριακών Συστημάτων και Χωρικής Ανάλυσης στη Γεωργία και στο 

Περιβάλλον, Αθήνα, 25-26 Μαΐου 2017 Αθανασάκης Γ., Ψωμιάδης Ε.). Στην παρούσα μελέτη 

χρησιμοποιήθηκαν δεδομένα του δορυφόρου της ESA, SENTINEL2 

Από τα μέσα της δεκαετίας του 80’ έχουν αναπτυχθεί πολυάριθμες τεχνικές τηλεπισκόπησης 

για την αξιολόγηση των αποτελεσμάτων για να εκτιμηθούν οι επιπτώσεις μιας πυρκαγιάς στο 

περιβάλλον. Σύγκριση παλαιών δορυφορικών εικόνων με νέες, καταλήγουν σε συμπεράσματα 

για τις αλλαγές στη βλάστηση μετά μια πυρκαγιά, ενώ η σύγκριση με ποιο πρόσφατες 

δορυφορικές εικόνες αναδεικνύουν τις φυσικές αλλαγές που έχουν προκληθεί στην επιφάνεια 

του εδάφους από μια πυρκαγιά. Πηγή: Marino O. et al., 2001, Methods of mapping burned 

furfaces in vegetation fires, book, Gitas I. 2007 (Towards an operational use of remote sensing in 

forest fires management, book) .  

         Η χαρτογράφηση της καμένης έκτασης γίνεται βάσει των αλλαγών στην ανάκλαση των 

επίγειων αντικειμένων μετά τη φωτιά, που συμβαίνουν στο εύρος του ηλεκτρομαγνητικού 

φάσματος (0,45–3μm).Αυτό συμβαίνει από την αλλαγή των φασματικών χαρακτηριστικών της 

γήινης επιφάνειας μετά από μια πυρκαγιά. Η χλωροφύλλη την φυτών ανακλά ισχυρά την 

υπέρυθρη ακτινοβολία, ενώ η υγρασία τους απορροφά άλλα μήκη κύματος με αποτέλεσμα την 

ισχυρή αντίθεση των φασματικών υπογραφών ανάμεσα στην καμένη έκταση και τη γύρω 

περιοχή. Η εδαφοκάλυψη από τα φυτά, η πυκνότητα της χλωροφύλλης και της περιεκτικότητας 

σε νερό της βλάστησης, μεταβάλλουν ταυτόχρονα το χρώμα και την ανακλαστικότητα 

(φωτεινότητα) του εδάφους. Στο σύνολό τους οι διάφορες μελέτες εκτίμησης καμένων περιοχών 

εξετάζουν τη μεταβολή στις φασματικές ή θερμικές ιδιότητες της γήινης επιφάνειας πριν και 

μετά από μια φωτιά Πηγή: Petropoulos G.  Tanvir Islam, 2017, (Remote sensing of  

hydrometeorogical hazards). 

Συγκεκριμένα όταν η βλάστηση καεί, στη χωρική διακριτική ικανότητα των περισσότερων  

δορυφορικών  αισθητήρων  (μέγεθος  pixel 30-10m)γίνεται μια δραστική μείωση στην ανάκλαση 

του ορατού-κοντινού υπέρυθρου (0,4-1,3μm). Η αύξηση της ανάκλασης στα μεγαλύτερα μήκη 

κύματος  οφείλεται στη μείωση της υγρασίας της βιομάζας. Σε μεγαλύτερες αναλύσεις (μέγεθος 

pixel<5m) η καύση μεγάλων ποσοτήτων ξύλου ή άλλων εύφλεκτων υλικών μπορεί σε ορισμένες 

περιπτώσεις να οδηγήσει σε αύξηση της ανακλαστικής επιφάνειας λόγω της μεγάλης απόθεσης 

λευκής στάχτης Πηγή: Lambin, 1998, Trigg and Flasse, 2000, Landmann, 2003, Roy and 

Landmann, 2005,  Smith and Hudak, 2005, S. Lentile et al, 2006, (Remote sensing techniques to 

acces active fire characteristics and post fire effects). 
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Οι αλλαγές στη ανάκλαση μετά την πυρκαγιά διαφοροποιούνται ανάλογα με το είδος της 

βλάστησης και τις ετήσιες διαφορές της εποχικής ανάπτυξης. Για το λόγο αυτό η στρωμάτωση 

μεταξύ ειδών βλάστησης, η σύγκριση εικόνων με ίδια βλάστηση και οι τεχνικές διαφοροποίησης 

εικόνων, οι οποίες περιλαμβάνουν εικόνες πριν και εικόνες ένα χρόνο μετά την πυρκαγιά, είναι 

ιδιαίτερα χρήσιμες για την αξιολόγηση των επιπτώσεων της πυρκαγιάς Πηγή: White et al., 1996; 

Cocke et al., 2005; Hudak et al., 2005;  Lentile et al., 2006, (Remote sensing techniques to acces 

active fire characteristics and post fire effects).  

Η παρατήρηση ευρέων φασματικών αλλαγών που οφείλονται στη φωτιά έχει οδηγήσει στη 

χρήση διαφόρων φασματικών δεικτών (συνδυασμοί διαφόρων φασματικών καναλιών), που 

περιλαμβάνουν το δείκτη NBR (Normalised Burn Ratio), το δείκτηd NBR (αποτελεί τη διαφορά 

μεταξύ του δείκτη NBR σε εικόνες πριν και  σε  εικόνες  μετά την πυρκαγιά) και  το δείκτη 

NDVI (Normalized Difference Vegetation Index). Οι δύο πρώτοι δείκτες χρησιμοποιούνται 

ευρέως για την εξέταση της δριμύτητας μιας πυρκαγιάς με τηλεπισκοπικά δεδομένα Πηγή: Carl 

Key and Nate Benson,  1999,  (Measuring and remote sensing of burn severity”.US Geological 

Survey and National Park Service).   

Σε ότι άφορα τα Γεωγραφικά  Συστήματα Πληροφοριών (G.I.S), τα οποία έχουν σχεδιαστεί 

για να διαχειρίζονται δεδομένα με γεωγραφική αναφορά, μπορούν να χρησιμοποιηθούν στη 

χαρτογράφηση  των καμένων  εκτάσεων  έτσι ώστε  να καταστεί  πιο εύκολη η εκτέλεση των 

πάσης φύσεων έργων για την μείωση των αρνητικών επιπτώσεων των πυρκαγιών. Tα G.I.S. 

μπορούν να συμβάλλουν στην επιλογή των καταλληλότερων θέσεων των αντιπλημμυρικών και 

αντιδιαβρωτικών έργων, χάριν του ψηφιακού μοντέλου εδάφους που δύνανται να 

επεξεργαστούν. Στην παρούσα μεταπτυχιακή μελέτη τα G.I.S. χρησιμοποιήθηκαν για τη 

δημιουργία χαρτών που απεικονίζουν την καμένη περιοχή καθώς και στην εξαγωγή δεδομένων 

και προτάσεων που αφορούν την διαχείριση της καμένης έκτασης.  

 

1.3 Μέθοδοι και εργαλεία τηλεπισκόπησης για την καταγραφή των επιπτώσεων μιας 

πυρκαγιάς. 

Η εκτίμηση των βραχυπρόθεσμων και των μακροπρόθεσμων αποτελεσμάτων μιας πυρκαγιάς 

σε τοπικό περιφερειακό και παγκόσμιο επίπεδο έχει πραγματοποιηθεί με τη χρήση ενός ευρέως 

φάσματος μεθόδων τηλεπισκόπησης και in situ. Σε ότι αφορά τις μεθόδους τηλεπισκόπησης, οι 

οποίες εκτιμούν τις επιπτώσεις μιας πυρκαγιάς στα τοπικά και περιφερειακά περιβάλλοντα, 

μπορούν να χωριστούν σε δυο κατηγορίες: 

1.   Μέθοδοι καμένης περιοχής και περιμέτρου, 
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2.  Μέθοδοι που εκτιμούν μια αλλαγή στην εδαφική επιφάνεια που έχει προκληθεί από τη 

φωτιά. (Lentile et al., 2006, Post fire burn severity and vegetation responce). 

Ο πιο απλός και κοινός τρόπος μέτρησης των αποτελεσμάτων  μετά  από  μια πυρκαγιά είναι ο 

χάρτης της καμένης περιοχής. Πιο συγκεκριμένα η ψηφιδωτή φύση μιας ψηφιακής εικόνας 

οδηγεί από  μόνη  της στη  χαρτογράφηση  της καμένης έκτασης. Ένας χάρτης της περιμέτρου 

μιας φωτιάς είναι μια διανυσματική απεικόνιση των ορίων της καμένης περιοχής, που μπορεί να 

καταστεί ψηφιακή από τις δορυφορικές εικόνες (raster to vector) ή από την μετακίνηση εντός 

των ορίων της καμένης περιοχής με ένα G.P.S..  

Οι μέθοδοι τηλεπισκόπησης με τη χρήση δορυφορικών εικόνων έχουν περισσότερα 

πλεονεκτήματα σε σχέση με τους χάρτες πεδίου περιμέτρου μιας πυρκαγιάς, καθώς η δεύτερη 

μέθοδος δεν μπορεί εκ των ενόντων να αποτυπώσει την ανομοιογενή καταστροφή της βλάστησης 

από την πυρκαγιά καθώς και τους άκαυτους θύλακες βλάστησης ή μεμονωμένα δένδρα. Ωστόσο 

οι χάρτες αυτοί παραμένουν σημαντικοί όταν η ατμόσφαιρα καλύπτεται από σύννεφα ή καπνό 

(ένα πρόβλημα το οποίο μειώνεται και με τη χρήση εικόνων υπερύθρου) ή όταν δεν είναι 

διαθέσιμα τηλεπισκοπικά δεδομένα. 

Η εκτίμηση των καμένων εκτάσεων με τηλεπισκόπιση γίνεται τις τελευταίες δεκαετίες με τη 

χρήση δεδομένων και εικόνων από εναέριους και δορυφορικούς αισθητήρες. Μέχρι τη δεκαετία 

του 80’, για παράδειγμα, η πλειοψηφία των τεχνικών είχαν αναπτυχθεί για δεδομένα που 

προέρχονταν από τον αισθητήρα AVHRR και για αυτό το λόγο είχαν περιοριστεί σε έναν μικρό 

εύρος θερμικών καναλιών και καναλιών ανάκλασης Πηγή: Al-Rawi, K.R., Casanova, J.L., Calle, 

A., (2001). (“Burned  area mapping  system and fire detection system, based on neuralnet works 

and NOAA-AVHRR imagery” International Journal of  Remote Sensing,Vol. 22,pp. 2015-2032). 

Παρόλο  που τα δεδομένα από  τον AVHRR περιορίζονται  από  ένα πολύ  μεγάλο μέγεθος 

εικονοστοιχείων (1,1km), παγκόσμια δεδομένα έχουν αποκτηθεί από μια σειρά διαφορετικών 

δορυφόρων για περισσότερα από 20 χρόνια, τα οποία μπορεί κάποιος να λάβει χωρίς καμία 

χρηματική επιβάρυνση και τα οποία επέτρεψαν την παρακολούθηση πυρκαγιών μεγάλου εύρους 

σε απομακρυσμένες και απομονωμένες περιοχές του κόσμου, όπως για παράδειγμα στις σαβάνες 

της Αφρικής και πέριξ του Αμαζονίου Πηγή: Lentile et al., 2006. 

Αργότερα κατασκευάστηκαν πιο εξελιγμένα δορυφορικά συστήματα με περισσότερους 

αισθητήρες που παρέχουν τόσο περισσότερα φασματικά κανάλια, όσο και περισσότερη χωρική 

και ραδιομετρική ικανότητα. Αυτού του είδους οι αισθητήρες χρησιμοποιήθηκαν συν τοις άλλοις 

για την αξιολόγηση καμένων περιοχών. Τέτοια συστήματα είναι ο MODIS, ο SPOT και ο 

Landsat. Επίσης, υπάρχουν προϊόντα που εφαρμόζουν συγκεκριμένους αλγόριθμους σε 
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διάφορους δορυφορικούς αισθητήρες, όπως είναι το GBA2000, το GLOBSCAR, το MODIS 

burned area product, κ.α.. 

Η πλειοψηφία των μελετών χρησιμοποιούν πληροφορία που αφορά τις διαφορές των 

φασματικών ή των θερμικών ιδιοτήτων της γήινης επιφάνειας πριν και μετά την πυρκαγιά. 

Υπάρχουν διάφοροι φασματικοί δείκτες που έχουν πρόσφατα αναλυθεί και δοκιμαστεί. Στη 

βιβλιογραφία  οι φασματικοί δείκτες περιλαμβάνουν τον Burned Area Index (Chuvieco et al., 

2002), μια θερμική παραλλαγή του Global Environmental Monitoring Index (Pereira,1999), 

διαφορετικές θερμικές παραλλαγές του VI-3 δείκτη (Barbosa et al., 1999a,1999b), θερμικά 

ενισχυμένες παραλλαγές κοινών δεικτών Πηγή: Holden et al., 2005 και Mid-infrared Bispectral 

Index (Trigg and Flasse, 2001) Carl H. Key, Nate Benson 1999 (‘‘Measuring and remote sensing 

burn severity, USGS). 

Λίγα χρόνια αργότερα έκαναν την εμφάνισή τους δορυφορικά συστήματα με αισθητήρες 

υψηλής χωρικής διακριτικής ικανότητας (μέγεθος εικονοστοιχείου 0,5-30m) που επιτρέπουν 

εκτίμηση του βαθμού ετερογένειας μέσα σε μεγάλες και απομακρυσμένες πυρκαγιές. Τέτοια 

δορυφορικά συστήματα είναι ο IKONOS, ο SPOT, ο Landsat και ο Quickbird. Ο Turner et al. 

(1994) με την χρήση δορυφορικών εικόνων από τον Θεματικό Χαρτογράφοτου Landsat 

εξερεύνησαν τις επιπτώσεις της πυρκαγιάς στη διαφοροποίηση στο τοπίο μετά τις πυρκαγιές του 

1988 στο Yellowstone. Πηγή: Lentile et al., 2006. 

 

1.4 Δείκτες εκτίμησης των επιφανειακών αλλαγών μετά από μια πυρκαγιά 

Η τηλεπισκόπηση δίνει τη δυνατότητα εκτίμησης των αλλαγών στην επιφάνεια της γης που 

προκύπτουν μετά από μια πυρκαγιά. Αυτό μπορεί να επιτευχθεί με η συσχέτιση δορυφορικών 

δεδομένων με διαφορετικά εδαφικά στοιχεία που καταδεικνύουν τη δριμύτητα μιας πυρκαγιάς 

και που σχετίζονται με την καταστροφή (Milne,1986; Miller and Yool, 2002) και τη θνησιμότητα 

της βλάστησης, Pattersonand Yool, 1998, Emilio Chvieco 2009,  Earth observation of wildland 

fires in Mediterranean ecosystems ). 

Ο δείκτης NDVI έχει χρησιμοποιηθεί ευρέως για την εκτίμηση της αναβλάστησης μετά  από  

μια  πυρκαγιά. Αυτός ο δείκτης αρκεί σε περιπτώσεις που η  κύρια οικολογική διαδικασία που 

εκτιμάται αφορά τις άμεσες αλλαγές στη βλάστηση. Πολλές μελέτες έχουν χρησιμοποιήσει τον 

δείκτη αυτό αλλά και άλλους παρόμοιους φασματικούς δείκτες για να εκτιμήσουν αλλαγές μετά 

από μια πυρκαγιά (Fiorella and Ripple, 1993; Henry and Hope,1998; Diaz-Delgado et al., 2003). 

Ο δείκτης παίρνει τιμές μεταξύ -1 και 1 και έχει χρησιμοποιηθεί και σε μελέτες κατανομής της 

δριμύτητας μιας πυρκαγιάς. Μάλιστα οι Diaz-Delgado et al., 2003, διαπίστωσαν μια θετική 
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συσχέτιση μεταξύ της μείωσης των τιμών του δείκτη και της δριμύτητας της φωτιάς. (Lopez, 

1991; Karl Key and Nate Benson, 1999). 

Η ανάπτυξη δυο φασματικών δεικτών και μάλιστα του MIRBI (Μidi-Infrared Bispectral 

Index) και του NBR (Normalized Burn Ratio) ενσωματώνει πληροφορία για τις φασματικές 

αλλαγές στην επιφάνεια προκειμένου να εξαχθούν συμπεράσματα για τις επιπτώσεις των 

πυρκαγιών. Ο δείκτης NBR συνδυάζοντας τις πληροφορίες από περιοχές του κοντινού 

υπερύθρου και του μέσου υπερύθρου έχει χρησιμοποιηθεί για τη διάκριση καμένων περιοχών της 

Μεσογείου χρησιμοποιώντας εικόνες μετά την πυρκαγιά (Lopez et al, 1991; Escuinetal., 2008). 

Εκτός όμως από τη μέτρηση των καμένων περιοχών ο NBR χρησιμοποιείται επίσης για την 

εξαγωγή συμπερασμάτων σχετικά με το βαθμό της οικολογικής αλλαγής μετά τη φωτιά. Ο 

δείκτης ορίζεται ως: 

NBR=(NIR-SIR/(NIR+SIR) 

Όπου NIR και SIR είναι οι φασματικές ανακλάσεις της  επιφάνειας όπως μετριούνται στα 

κανάλια 8 (0.785 - 0.900μm )και12 (2.100 - 2.280μm) του Βελτιωμένου Θεματικού 

Χαρτογράφου του SENTINEL2. Όπως και ο δείκτης NDVI, παίρνει τιμές από -1 έως1. Σε 

περιοχές με βλάστηση παίρνει θετικές τιμές, ενώ οι αρνητικές τιμές αναφέρονται σε γυμνό 

έδαφος. Στις καμένες περιοχές οι τιμές του δείκτη μειώνονται ενώ η δριμύτητα της φωτιάς 

ανεβαίνει. 

Άλλοι  δείκτες  που  συναντά   κανείς  στη   βιβλιογραφία,  σαν   δείκτες  που καταδεικνύουν 

τη δριμύτητα μιας πυρκαγιάς, είναι ο δείκτης  dNBR (δείκτης της διαφοράς μεταξύ του  NBR 

πριν και μετά  την πυρκαγιά) και ο  δείκτης CBI (Composite Burnt Index), οι οποίοι 

χρησιμοποιούνται από τις δασικές υπηρεσίες των δυτικών Η.Π.Α. Πηγή: Wagtendonk et 

al.,2004; Cocke et al., 2005, Kokaly et al., 2006; Howard and Lacasse, 2004; Escuin et al., 2008. 

 

Κανονικοποιημένος δείκτης βλάστησης Normalized Difference Vegetation Index (NDVI). 

Ο κανονικοποιημένος δείκτης βλάστησης υπολογίζει τη ζωτικότητα της βλάστησης. Η αρχή 

που βασίζεται είναι: " η χρωστική των φύλλων των φυτών, η χλωροφύλλη, απορροφά σε υψηλά 

ποσοστά το ορατό φως (από 0,7 έως 0,11 mμ). Εάν η ανακλώμενη ακτινοβολία στο εγγύς 

υπέρυθρο μήκος κύματος είναι πολύ περισσότερη απ΄ ότι στο ορατό μήκος κύματος, τότε η 

βλάστηση στο συγκεκριμένο εικονοστοιχείο πιθανόν να είναι πυκνή" (Chang, Kaixu Bai, 2018). 

Η μαθηματικήσχέση του δείκτη είναι: 
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Όπου NIR το εγγύς υπέρυθο Β8 κανάλι και RED το Β4 κανάλι. Οι τιμές του δείκτη 

κυμαίνονται από -1 έως 1. Αρνητικές τιμές, δηλώνουν συνήθως σύννεφα, χιόνι, νερό ή περιοχές 

χωρίς βλάστηση.  

Όσο υψηλότερες είναι οι τιμές του κανονικοποιημένου δείκτη, τόσο πιο έντονη είναι η 

παρουσία βλάστησης στο εικονοστοιχείο. Ωστόσο, ο NDVI έχει ιδιαίτερες αδυναμίες. Οι 

ατμοσφαιρικές συνθήκες και τα σύννεφα μπορούν να επηρεάσουν τις τιμές του. Όταν η κάλυψη 

τη βλάστησης είναι χαμηλή κάτω από την κόμη συμβάλουν και άλλα χαρακτηριστικά στο 

καταγραφόμενο σήμα ανάκλασης. Αυτό μπορεί να είναι γυμνό έδαφος, κατάλοιπα βλάστησης ή 

κάποιο άλλο είδος βλάστησης. Κάθε ένα από τα παραπάνω όμως, έχει διαφορετική φασματική 

απόκριση από το είδος βλάστησης που μελετάται (Ni-Bin Chang, Kaixu Bai, 2018, Multisensor 

data fusion and machine learning for environmental remote sensing). 

 

1.5 

Τα Sentinel 2 προϊόντα (Level 1C) διατίθενται μέσω του Copernicus Open Access Hub ως 

σύνολα δεδομένων ορθοεικόνων των 100 km2 σε UTM/WGS84 προβολή με την πληροφορία της 

ανακλαστικότητας στην κορυφή της ατμόσφαιρας (top-of-atmospherere flectance). Το UTM 

(Universal Transverse Mercator) σύστημα χωρίζει την επιφάνεια της γης σε 60 ζώνες. Κάθε ζώνη 

UTM έχει κάθετο πλάτος 6° γεωγραφικού μήκους και οριζόντιο πλάτος 8° γεωγραφικού 

πλάτους. Με το σύστημα αυτό τα πλακίδια (tiles) καλύπτονται είτε πλήρως είτε μερικώς από τα 

δεδομένα της εικόνας. Τα μερικώς καλυμμένα αντιστοιχούν στα άκρα της λωρίδας σάρωσης. Το 

κάθε πλακίδιο (tile) έχει μέγεθος 500 MB. Τα Level 1C προκύπτουν από τα Level 1B προϊόντα 

τα οποία είναι ραδιομετρικά διορθωμένα σε τιμές ακτινοβολίας στην κορυφή της ατμόσφαιρας 

και έχουν την γεωμετρία του δορυφόρου. Το κάθε πλακίδιο (granule) έχει έκταση 25×23 

km2.Κάθε tile αποτελείται από 13 JPEG-2000 εικόνες όσα και τα φασματικά κανάλια, ενώ κάθε 

προϊόν περιλαμβάνει ένα σύνολο από tiles (περίπου 10-16).  

Τον ελληνικό χώρο συνθέτουν 64 tiles (εκ των οποίων τα 29 ανήκουν στην ζώνη 34 και τα 

υπόλοιπα 35 στην ζώνη 35) το καθένα από τα οποία διαθέτει μοναδικό κωδικό. Η κωδικοποίηση 

αυτή εξυπηρετεί στην διαχείριση και οργάνωση των Sentinel 2 δεδομένων.  
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1.6  

 

Από  την Ελληνική και Διεθνή ανάλυση της βιβλιογραφίας, προέκυψε το πλήθος των 

εργασιών  που ειδικευονται στην καταγραφή των πυρκαγιών των δασών και άλλων 

εκτάσεων με τη χρήση των δορυφορικών εικόνων. Ερευνήθηκαν εργασίες τόσο ειδικά για 

τη νήσο Χίο, όσο και άλλες περιοχές του πλανήτη. Από αυτές τις εργασίες διαμορφώθηκε 

το θεωρητικό πλαίσιο της παρούσας εργασίας. Από αυτές οι παρακάτω εργασίες 

αποτέλεσαν τον πυλώνα στον οποίο στηρίχτηκε η μεθοδολογία υπολογισμού της καμένης 

έκτασης .  

Στην ιστοσελιδα  της esa παρατίθενται ένα πλήρες παράδειγμα υπολογισμού της καμένης 

έκτασης στην Πορτογαλία το 2016, το οποίο αποτελεί πλήρη οδηγό μέχρι την εξαγωγή  του 

παραδοτέου  Geotiff.  (Πηγή:  https://ruscopernicus.eu) 

 

1)  Στην εργασία των  Bambang Trisakti et al 2016, Technique for identifying burned 

vegetation area using  Landsat 8 data, γίνεται η καταγραφή των καμένων εκτάσεων με 

χρήση Δορυφορικών Εικόνων Landsat, διακριτικής ικανότητας 30μ.. 

 

2)  Σύμφωνα με τον Carl (2006) στην εργασία του με τίτλο Measurig and remote sensing 

of burn severity, γίνεται αναφορά στην χρήση των δεικτών NDVI και NBR για να 

αποτυπωθούν οι καμένες εκτάσεις και η δριμύτητα της πυρκαγιάς στα Βραχώδη Όρη. 
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 3) Στην εργασία των  Leigh B. et al (2006),  γίνεται αναφορά στον τρόπο με τον οποίο 

υπολογίζονται με δορυφορικές εικόνες, η δριμύτητα της πυρκαγιάς και της καμένης 

έκτασης καθώς και οι επιπτώσεις στο περιβάλλον. 

                  

 4) Ο Αθανασακης (2018), πραγματευτηκε την χαρτογραφηση και  αποτίμηση της 

πυρκαγιάς στη νήσο Χίο με χρήση δορυφορικών εικόνων Landsat, χρήση δεικτών NDVI 

και NBR και έλεγχο αναβλάστησης μετά λίγους μήνες από την πυρκαγιά. 

 

5) Η Μίμίδου Χ. (2014), διερευνησε  τις περιβαλλοντικες και ανθρωπογενεις επιπτώσεις, 

αποτίμησε την πυρκαγιά στη νήσο Χίο του έτους 2012, με χρήση δορυφορικών εικόνων, 

χρήση δεικτών NDVI και NBR, καταγράφοντας και τις οικονομικές επιπτώσεις της 

πυρκαγιάς. 

 

6) H Εκτίμηση της σφοδρότητας των δασικών πυρκαγιών με την χρήση πολύ υψηλής 

ανάλυσης δορυφορικών εικόνων: Η περίπτωση της νήσου Χίου, μελετήθηκε από 

Μητσόπουλος  κ.α. (2017). Στην εργασία αυτή γίνεται η αποτίμηση της πυρκαγιάς στη 

νήσο Χίο το έτος 2016, με χρήση δορυφορικών εικόνων WorldView-2. Η ανάπτυξη και 

αξιολόγηση της προσέγγισης πραγματοποιήθηκε με επίγειες μετρήσεις και τη χρήση 

του Σύνθετου Δείκτη Σφοδρότητας Καύσης (CBI), και σημείων τυχαίας 

δειγματοληψίας στην καμένη περιοχή. 

 

7) Η WWF Ελλάς πραγματοποίησε τον Οικολογικό απολογισμό της πυρκαγιάς του 

Ιουλίου 2016  στη Χίο και την  οικολογική αποτίμηση με χρήση δορυφορικών εικόνων 

και επιτόπιες  έρευνες. 

 

   Οι εργασίες που αφορούν την πυρκαγιά του 2016 στη νήσο Χίο, αποτέλεσαν το βοήθημα   

 για την αποτίμηση της ακρίβειας της μεθόδου της παρούσας εργασίας.  
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ΚΕΦΑΛΑΙΟ 2. ΜΕΘΟΔΟΛΟΓΙΚΟ ΠΛΑΙΣΙΟ  

2.1 Διάγραμμα ροής μεθοδολογίας παρούσης εργασίας 

  Ιδιαίτερη βαρύτητα δόθηκε στη μεθοδολογία που ακολουθείται στο παράδειγμα για τον 

υπολογισμό της καμένης έκτασης από την μεγάλη πυρκαγιά στην Πορτογαλία  το 2016, που 

υπάρχει στην ιστοσελίδα της esa.  

(Πηγή: https://rus-copernicus.eu/portal/wpcontent/uploads/library/education/training/HAZA02_ 

BurnedArea_Portugal_Tutorial.pdf 

Η  Μεθοδολογία που ακολουθήθηκε για την καταγραφή των καμένων εκτάσεων, περιγράφεται 

αναλυτικά διάγραμμα ροής: 
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    Πηγή: Bambang Trisakti, Udhi Catur Nugroho and Any Zubaidah Remote Sensing  Application 

Center, 2016, Technique for identifying burned vegetation area using  Landsat 8 data. 

2.2 Τα βήματα που ακολουθήθηκαν στην παρούσα εργασία είναι τα παρακάτω: 

 

Ανεύρεση και προμήθεια δορυφορικών εικόνων της νήσου Χίου. 

Ατμοσφαιρική διόρθωση των δορυφορικών εικόνων προκειμένου να διορθωθούν   

σφάλματα και να γίνουν πιο καθαρές. 

Δημιουργία cloud mask για να απαλειφθούν τα σύννεφα. 

Mάσκα land/sea προκειμένου να απαλειφθούν οι περιοχές που περιλαμβάνουν   

Θάλασσα και είναι δυνατόν να δημιουργήσουν προβλήματα στην επεξεργασία. 

Subset – Επιλογή καναλιών προκειμένου να γίνει μόνο η επολογή της περιοχής  

μελέτης και τα κανάλια που μας ενδιαφέρουν. 

Normalized Burn Ratio (NBR). Ορίζουμε τον μαθηματικό δείκτη της έντασης της  

πυρκαγιάς. 

Δημιουργία Γραφήματος Graph Builder και Batch Processing τα οποία θα βοηθήσουν   

στην παραπέρα επεξεργασία των δορυφορικών εικόνων. 

Collocation  προκειμένου να γίνει η ταύτιση των δύο διαφορετικών δορυφορικών  

εικόνων για να υπολογιστεί μετέπειτα ο δείκτης (NBR). 

Clound Mask προκειμένου να απαλειφθούν οι περιοχές μα σύννεφα. 

Burned areas and burn severity προκειμένου να γίνει οπτική απεικόνιση της έντασης    

της πυρκαγιάς. 

Export as Geo TIFF προκειμένου να γίνει η μετέπειτα επεξεργασία με το  Arc Map 

Επεξεργασία στο Arc Map 10.2.1 

Παρουσίαση αποτελεσμάτων στο GOOGLE EARTH. 

Εμβαδομέτρηση καμένης έκτασης στο σύνολο όλων των κατηγοριών χρήσης γης. 

Ταξινόμηση καμένης έκτασης ανά κατηγορία χρήσης γης. 

Υπολογισμός ακρίβειας και σύγριση με άλλα αποτελέσματα άλλων ταξινομήσεων. 
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ΚΕΦΑΛΑΙΟ 3. Εφαρμογή αποτίμησης καμένης έκτασης στη νήσο Χίο. 

 

3.1 Δορυφορικά Δεδομένα. 

Στα πλαίσια της παρούσας εργασίας τα Sentinel 2 δεδομένα για τη νήσο Χίο αποκτήθηκαν 

μέσω της ιστοσελίδας https://scihub.copernicus.eu/dhus/#/home που καλύπτουν το σύνολο του 

ελληνικού χώρου. Τα δεδομένα που επιλέχτηκαν αφορούν τις ημερομηνίες 17-06-2016 και 27-

07-2016 και την περιοχή με tiles 35SMC, με πολύ μικρό ποσοστό από σύννεφα, τα οποία 

εντοπίζονται κυρίως στον θαλάσσιο χώρο και εκτός της μελετούμενης περιοχής.  

 

 

 

3.2 Περιγραφή περιοχής μελέτης.    

Γενικά 

Η περιοχή μελέτης της παρούσας μεταπτυχιακής διατριβής είναι η νήσος Χίος και 

συγκεκριμένα η περιοχή εκείνη που επλήγη από την πυρκαγιά της 25-7-2016 που αποτέφρωσε 

περίπου 40.000 στρέμματα τόσο δασικής όσο και γεωργικής έκτασης  και βοσκοτόπων. 

 Η  περιοχή  ανήκει γεωγραφικά  στο Βορειοανατολικό Αιγαίο, στο νομό Χίου που 

συμπεριλαμβάνει εκτός από τη νήσο Χίο, τις Οινούσσες και τα Ψαρά. Η νήσος Χίος είναι το 5
ο  

μεγαλύτερο νησί της Ελλάδας (συνολική έκταση νησιού 842,54km
2 

και ανήκει στο σύμπλεγμα 

των νησιών που απαρτίζουν το Βορειοανατολικό Αιγαίο. Στα νησιά αυτά συμπεριλαμβάνονται η 

Λέσβος, η Λήμνος, η  Σάμος, η Ικαρία και ο Αγ.  Ευστράτιος. 

Η πληγείσα από την πυρκαγιά περιοχή εκτείνεται από τα κεντρικά του νησιού προς τα νότια. 

Καταλαμβάνει έκταση 45km
2
και καλύπτει το 2% του νησιού. Η περιοχή αυτή περιλαμβάνει 

πολλά χωριά και κυρίως τα Μαστιχοχώρια, τα οποία είναι γνωστά για την παραγωγή της 

μαστίχας. Γι’ αυτόν κυρίως το λόγο η πληγείσα περιοχή έχει και ιδιαίτερο ενδιαφέρον μελέτης, 

επειδή καταστράφηκε ένας αρκετά μεγάλος αριθμός μαστιχόδενδρων και ελαιόδεντρων, τα 

οποία αποτελούν τον οικονομικό πόρο της περιοχής. Ωστόσο, εκτός από τις αγροτικές 

καλλιέργειες, η περιοχή μελέτης αποτελείται σε ένα μεγάλο ποσοστό από δασικές εκτάσεις 

κυρίως θαμνώνες στα βόρεια και κεντρικά λίγα δάση πεύκης και λίγους βοσκότοπους. Το 
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γεγονός ότι ένα μέρος της Χίου έχει καεί ξανά στο παρελθόν δημιουργεί προβληματισμό σχετικά 

με τον αυξημένο κίνδυνο διάβρωσης, πλημμυρών και υπερβόσκησης, καθώς δεν υπάρχει 

δυνατότητα άμεσης  οικολογικής αποκατάστασης, αλλά και θέματα στήριξης της τοπικής 

οικονομίας, θέματα αποζημιώσεων που πηγάζουν κυρίως από την καταστροφή των μόνιμων 

καλλιεργειών.  

Ιδιαίτερα η υπερβόσκηση είναι πολύ σοβαρή απειλή για τα δασικά οικοσυστήματα της Χίου, 

επειδή λόγω των μεγάλων πυρκαγιών των τελευταίων χρόνων, δεν υπάρχουν διαθέσιμες εκτάσεις 

για βόσκηση.  

 

 

 

Εικόνα 1. Απεικόνιση της νήσου Χίου από δορυφορική εικόνα Landsat 5 

(RGB 4,3,2) 
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Εικόνα 2.  Τοπογραφικός-Πολιτικός χάρτης Χίου 
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Κλιματολογικά χαρακτηριστικά 

Η νήσος Χίος βρίσκεται στο Βορειοανατολικό Αιγαίο, στο ανατολικότερο από τα τέσσερα 

τμήματα στα οποία διαιρείται η Μεσόγειος θάλασσα. Λόγω της θέσης της το κλίμα της υπάγεται 

στον τόπο των Ετήσιων Ανέμων (μελτεμιών), οι οποίοι πνέουν στο Αιγαίο κατά το θέρος και 

διαμορφώνουν τον ιδιαίτερο χαρακτήρα του Μεσογειακού κλίματος κατά μήκος του Αιγαίου. Ο 

κλιματικός τύπος των ετήσιων ανέμων σε γενικές γραμμές χαρακτηρίζεται από ήπιους χειμώνες, 

σχεδόν δροσερά καλοκαίρια, μέτριες ή χαμηλές βροχοπτώσεις, μεγάλη διάρκεια πραγματικής 

θερινής ξηρασίας και ισχυρούς ανέμους βορείου τομέα.  

Στις κλιματικές περιοχές που παρουσιάζονται στο χάρτη της Εικόνας 1, η Χίος ανήκει στην 

περιοχή με μέτριες βροχοπτώσεις, ήπιους χειμώνες και ξηρά καλοκαίρια. Επίσης στον Πίνακα 1 

δίδονται τα μετεωρολογικά δεδομένα 1973– 2001. 
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Εικόνα 3. Χάρτης κλιματικών περιοχών της Ελλάδας (πηγή Διαδίκτυο και WWF Ελλάς 

«Οικολογικός απολογισμός της πυρκαγιάς του Ιουλίου 2016 στη Χίο: 

Γενικά στοιχεία, επιπτώσεις, προτάσεις»., Αθήνα, Οκτώβριος2016). 

 

 

Πίνακας 1.  Μετεωρολογικά δεδομένα για τα έτη 1973-2001  (Πηγή:  Ε.Μ.Υ) 

 

 ΙΑΝ ΦΕ

Β 

ΜΑΡ ΑΠ

Ρ 

Μ

ΑΙ 

ΙΟΥ

Ν 

ΙΟΥ

Λ 

ΑΥ

Γ 

ΣΕ

Π 

ΟΚ

Τ 

ΝΟ

Ε 

ΔΕΚ 

Μέση 

θερμοκρασία 

(Co) 

9,6 9,8 11,7 15,3 19,7 24,3 26,7 26,2 22,8 18,3 13,8 11,1 

Μέση 

μέγιστη 

θερμοκρασία 

(Co) 

12,4 12,9 14,9 18,7 23,1 27,9 30,2 29,7 26,4 21,9 16,7 13,6 

Μέση 

ελάχιστη 

θερμοκρασία 

(Co) 

6,1 6,3 7,3 9,9 13,7 17,8 21,1 21 17,4 13,8 10 7,6 

Απόλυτα 

μέγιστη 

θερμοκρασία 

(Co) 

19,4 22 24 27,8 35,6 39 39 40,6 35 32,8 25,4 21,4 

Απόλυτα 

ελάχιστη 

θερμοκρασία 

(Co) 

-4 -4 -3 0,2 5 9,4 11 11 5,8 3,4 -0,6 -2 

Μέση 

νέφωση 

(όγδοα) 

4,3 4,4 3,8 3,3 2,4 0,9 0,3 0,3 0,9 2,3 3,7 4,4 

Διάρκεια 

βροχοπτώσεων 

(ημέρες) 

7,9 7,5 6,4 5,3 2,3 0,3 0,1 0 0,9 2,6 7,3 9,1 

Βροχόπτωση 

(mm) 

96,8 77,1 66,5 34,6 13,1 1,1 0 0 11,7 27,2 82,1 116,6 

Σχετική   

υγρασία(%) 

73,2 72,4 71,8 69,8 67,4 61,4 57,7 59,6 63,6 70,9 74,8 74,3 

 

Από τον παραπάνω πίνακα διαπιστώνεται ότι κατά τους καλοκαιρινούς μήνες οι πιθανότητες 

εκδήλωσης  μίας  πυρκαγιάς  είναι πολύ  μεγάλες,  ιδιαίτερα όταν στην περιοχή   πνέουν  ισχυροί  

άνεμοι.  Οι  άνεμοι  στο  νησί  είναι  κυρίως  βόρειας κατεύθυνσης με τη μέγιστη ένταση να 

παρατηρείται τους μήνες Δεκέμβριο – Μάρτιο και την ελάχιστη κατά τους μήνες Απρίλιο – 

Ιούνιο. 
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Στην περιοχή της Νέας Μονής υπάρχει βροχομετρικός σταθμός του Υπουργείου Αγροτικής 

Ανάπτυξης. Σύμφωνα με στοιχεία από το αρμόδιο τμήμα της Περιφερειακής ενότητας Χίου οι 

βροχοπτώσεις στην περίοδο 1990-2010 είναι οι αναφερόμενες του παρακάτω πίνακα. 

 

 

 

 

 

 

 

Έτος ΙΑΝ ΦΕΒ ΜΑΡ ΑΠΡ ΜΑΪ ΙΟΥΝ ΙΟΥΛ ΑΥΓ ΣΕΠ ΟΚΤ ΝΟΕ ΔΕΚ 

1990 0,0 44,0 0,00 111,00 0,00 0,0 0,00 4,00 0,00 22,00 22,00 400,0 

1991 82,0 125,0 41,5 106,00 55,00 0,0 0,00 0,00 0,00 0,00 80,00 225,0 

1992 0,0 50,00 95,50 34,00 11,00 8,00 0,00 0,00 0,00 0,00 65,00 145,0 

1993 55,0 175,00 95,00 50,00 60,00 0,0 0,00 0,00 0,00 0,00 90,00 55,0 

1994 172,0 160,00 73,00 11,00 102,00 0,0 0,00 0,00 0,00 155,00 85,00 150,0 

1995 220,0 35,00 130,00 20,00 0,00 0,0 0,00 0,00 0,00 0,00 110,00 90,0 

1996 270,00 325,00 87,00 50,00 55,00 0,0 0,00 0,00 65,00 30,00 85,00 180,0 

1997 40,00 70,00 90,00 10,00 0,00 0,0 10,00 0,00 0,00 80,00 40,00 365,0 

1998 55,00 110,00 158,00 1,00 44,00 0,0 0,00 0,00 35,00 49,00 213,00 152,0 

1999 130,00 43,00 141,00 60,00 0,00 0,0 0,00 0,00 37,50 35,50 32,00 56,0 

2000 58,00 112,00 67,00 44,00 0,00 0,0 0,00 0,00 0,00 60,00 115,00 61,0 

2001 195,00 60,00 0,50 47,50 10,50 0,0 0,00 0,00 5,00 0,00 187,00 242,0 

2002 116,50 25,00 101,00 70,00 2,00 0,0 30,00 0,00 92,00 38,00 206,00 400,5 

2003 101,50 190,00 97,00 92,00 17,00 0,0 0,0 0,00 25,00 93,50 11,50 193,5 

2004 433,00 61,50 25,00 129,50 52,50 0,0 0,0 0,00 0,00 0,00 75,50 388,5 

2005 209,50 325,40 80,70 7,50 21,00 0,0 0,0 7,50 0,00 6,50 505,00 98,00 

2006 108,00 89,00 376,00 45,50 0,00 8,00 0,0 0,00 62,00 145,00 53,00 16,50 
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Γεωλογία 

Το νησί της Χίου παρουσιάζει αξιόλογο γεωλογικό ενδιαφέρον και μεγάλη γεωλογική και 

τεκτονική πολυπλοκότητα. Τα πετρώματα που απαντώνται κατά κύριο λόγο είναι Κλαστικά 

και ανθρακικά ιζήματα του Παλαιοζωικού, του Μεσοζωικού και του Νεογενούς ποικίλης 

λιθολογικής σύστασης. 

 Οι κυριότεροι γεωλογικοί σχηματισμοί του νησιού έχουν ηφαιστειογενή και ασβεστολιθική 

προέλευση. Τα πετρώματα που εντοπίζονται κυρίως στη Βορειοδυτική πλευρά του νησιού είναι 

ως επί το πλείστον ιζηματογενή και δημιουργήθηκαν σε διάφορες γεωλογικές περιόδους άλλα σε 

θαλάσσιες και άλλα σε λιμναίες περιοχές από αιωρούμενα σωματίδια, κυρίως κελύφη μικρών 

πλαγκτονικών οργανισμών, που κατακάθισαν στον πυθμένα, συμπιέστηκαν ισχυρά και μαζί με 

τη δράση χημικών διεργασιών μετατράπηκαν σε συμπαγείς λίθινες μάζες. Τα πετρώματα αυτά 

θεωρείται ότι είναι τα αρχαιότερα στην Ελλάδα (μαζί με τα πετρώματα που έχουν βρεθεί στο 

νησί της Κω). Στη Χίο εντοπίζονται ηφαιστειακά πετρώματα κυρίως στον Εμπορειό, στην Κώμη, 

στην Καμπιά και στα Καρδάμυλα αλλά και μεγάλης έκτασης ασβεστολιθικές περιοχές με 

χαρακτηριστικές τεκτονικές επωθήσεις, ρήγματα και καρστικές δομές όπως ξηρές κοιλάδες, 

φαράγγια, δολίνες, πόλγες, ασβεστολιθικά πεζοδρόμια, σπήλαια (χαρακτηριστικά  είναι το 

σπήλαιο του Αγίου Γάλακτος και το σπήλαιο των Ολύμπων), βάραθρα. 

Στην νότια περιοχή της Χίου η ύπαρξη αργίλου δίνει δυνατότητες ανάπτυξης της 

κεραμοπλαστικής. Στο νοτιοανατολικό τμήμα λειτουργούσαν παλαιότερα λιγνιτωρυχεία ενώ στο 

βορρά βρίσκει κανείς εκμεταλλεύσιμα κοιτάσματα αντιμονίου στο χωριό Kέραμος και  

θειοσιδηρούχες ιαματικές πηγές στον οικισμό Aγιάσματα. 

 Επίσης, τα μάρμαρα της Χίου είναι πολύ ιδιαίτερα, καθώς και η πιο μαλακή «θυμιανούσικη 

πέτρα» με σκούρο χρώμα, που χρησιμοποιούνται ως δομικά υλικά. Ακόμη, άξια μορφολογικού 

και τεκτονικού ενδιαφέροντος είναι το ηφαίστειο του Εμπορειού και το σεισμικό ρήγμα που 

2007 115,70 90,20 110,00 30,50 178,00 6,50 0,0 0,00 0,00 172,00 186,00 161,00 

2008 113,00 34,00 81,00 193,10 0,00 0,0 0,0 0,00 58,50 10,00 121,00 204,00 

2009 237,00 150,80 222,70 61,70 6,00 15,1 0,0 0,00 35,00 39,00 198,80 473,80 

2010 135,00 336,00 8,50 27,00 40,50 28,0 0,0 0,00 3,00 265,50 22,00 175,00 
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εντοπίζεται στο δρόμο από τη Χίο προς το νότο, πριν το χωριό Θολό ποτάμι, μήκους 

μεγαλύτερου από 3km. 

 Στην Εικόνα 4 παρουσιάζεται ο γεωλογικός χάρτης του νησιού όπου εκτός από τα πετρώματα 

φαίνονται και τα ρήγματα και στην Εικόνα 5 η υδρογεωλογία του νησιού με έμφαση να δίνεται 

στην περατότητα των σχηματισμών. (Πηγή: Μιμίδου Χ. «Διερεύνηση περιβαλλοντικών και 

ανθρωπογενών επιπτώσεων της πυρκαγιάς του 2012 στη νήσο Χίο με χρήση τηλεπισκόπησης και 

GIS και WFΕλλάς «Οικολογικός απολογισμός της πυρκαγιάς του Ιουλίου2016 στη Χίο: Γενικά 

στοιχεία, επιπτώσεις, προτάσεις»., Αθήνα, Οκτώβριος 2016). 
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ΕΙΚΌΝΑ 4. Γεωλογικός χάρτης της περιοχής μελέτης 

 

 

 

 

 

 

Institutional Repository - Library & Information Centre - University of Thessaly
03/06/2024 03:54:29 EEST - 3.15.15.125



 

29 
 

 

Εικόνα 5. Υδρογεωλογικός χάρτης της νήσου Χίου 

 

 

 

 

 

Γεωμορφολογία 
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Σε ότι αφορά τα μορφολογικά χαρακτηριστικά, το νησί θα μπορούσε να χαρακτηριστεί 

συνολικά ως ορεινό, καθώς το μεγαλύτερο τμήμα της επιφάνειάς του είναι ορεινό και τραχύ με 

μέσο υψόμετρο τα 400m. Αναλυτικότερα το κεντρικό και βόρειο τμήμα χαρακτηρίζεται από 

έντονο και τραχύ τοπογραφικό ανάγλυφο, ενώ όσο κινούμαστε νοτιότερα το ανάγλυφο τείνει να 

γίνεται ηπιότερο με χαμηλότερο υψόμετρο και παρουσία λόφων με ομαλές κλίσεις στις πλαγιές 

και αβαθή ρέματα. 

Το πλέον σημαντικότερο είναι το Πεληναίο Όρος που φτάνει τα 1297μ., με σχετικά απότομες 

πλαγιές και χαράδρες, στο κέντρο του βορείου τμήματος. Προς τα δυτικά εκτείνεται η μικρή 

οροσειρά της Αμανής (809m) που καλύπτει ολόκληρο το Βορειοδυτικό τμήμα του νησιού, ενώ 

νοτιότερα απαντά το Όρος Έπος (1186μ), ο Κοχλίας (926μ), η Κακή Ράχη (525μ), ο Τράχωνας 

(377μ), ο Κορακάρης (309μ) (Παΐδας, 2011). 

Σχετικά ηπιότερο ανάγλυφο επικρατεί στο νοτιοανατολικό τμήμα του νησιού, όπου και η  

προς αξιοποίηση περιοχή  και το  βορειοδυτικό τμήμα, όπου επικρατούν ψαμμίτες και 

σχιστόλιθοι του Παλαιοζωικού αιώνα. 

Στο νοτιοανατολικό παράκτιο τμήμα του νησιού απαντούν μικρές κοιλάδες και επί των 

ορεινών περιοχών μικρά οροπέδια. Τα πεδινά τμήματα είναι πολύ λίγα, με το κυριότερο εξ 

αυτών να είναι ο Κάμπος, 5km νότια της πόλης της Χίου και η μικρή πεδιάδα της Βολισσού 

40km βορειοδυτικά της πόλης. 

Πυκνό υδρογραφικό δίκτυο δενδριτικής μορφής αναπτύσσεται στο βορειοδυτικό τμήμα του 

νησιού όπου επικρατούν αδιαπέρατα πετρώματα. Στο υπόλοιπο και μεγαλύτερο τμήμα του 

νησιού, το υδρογραφικό δίκτυο είναι αραιότερο και αυτό οφείλεται στην μεγαλύτερη κατείσδυση 

των επιφανειακών υδάτων σε υδροπερατά πετρώματα. 

Το νησί μπορεί να χωριστεί στις εξής μορφολογικές ενότητες: 

   ΝΑ ενότητα: Λοφώδης– ημιορεινή με ιζήματα της νεογενούς περιόδου 

   Ν-ΝΔ ενότητα: Ημιορεινή με λιγότερο τραχύ ανάγλυφο 

 Β-Κεντρική: Ορεινή με έντονο και τραχύ ανάγλυφο, όπου επικρατούν μεσοζωικοί 

ασβεστόλιθοι 

 ΒΔ ενότητα: Ημιορεινή – ορεινή, όπου επικρατούν ψαμμίτες και σχιστόλιθοι του 

Παλαιοζωικού (Παΐδας, 2011). 

 

Στους παρακάτω πίνακες  (Πίνακας  4  &  5) δίνονται  οι  μορφολογικές κλίσεις και ο 

προσανατολισμός των κλίσεων σε έκταση και ποσοστό επί του συνόλου του νησιού. 
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 Πίνακας 4.  Μορφολογικές κλίσεις της περιοχής μελέτης 

Χαρακτηρισμός Μορφολογικές 

κλίσεις 

(%) 

Έκταση 

(km2) 

Ποσοστό 

(%) 

Επίπεδες περιοχές – 

πολύ ήπια κλίση 

0-5 74,22 8,82 

Ήπια κλίση 5-10 86,29 10,25 

Μέτρια κλίση– μέτρια 

απότομη κλίση 

10-20 162,13 19,27 

Απότομη κλίση 20-45 346,42 41,17 

Πολύ απότομη κλίση >45 172,43 20,49 

Συνολική έκταση νησιού 842,5 100 

 

 Πίνακας 5.  Προσανατολισμός κλίσεων των  πρανών  της περιοχής μελέτης 

Προσανατολισμός κλίσεων (σε μοίρες) Έκταση 

(km2) 

Ποσοστό(%) 

0-90 (ΒΑ) 205,65 24,44 

90-180 (ΝΑ) 232,24 27,60 

180-270 (ΝΔ) 198,49 23,59 

>270 (ΒΔ) 205,11 24,37 

Συνολική έκταση νησιού 842,5 100 

 

Επίσης, παρακάτω παρατίθενται ο μορφολογικός χάρτης (Εικόνα 6) , ο χάρτης του ψηφιακού 

υψομετρικού μοντέλου( DEM) (Εικόνα 7), οι χάρτες μορφολογικών κλίσεων (Εικόνα 8) και 

προσανατολισμού των κλίσεων (Εικόνα 9) και ο χάρτης λεκανών απορροής τη περιοχής μελέτης 

(Εικόνα 10). Ο μορφολογικός χάρτης και ο χάρτης λεκανών απορροής προέκυψαν από 

ψηφιοποίηση των τοπογραφικών χαρτών, φύλλα Βολισσός, Βροντάδος, Καρδάμυλα και Μεστά 

της Γ.Υ.Σ. Ο χάρτης ψηφιακού υψομετρικού μοντέλου, ο χάρτης μορφολογικών κλίσεων και ο 

χάρτης προσανατολισμού των κλίσεων προέκυψαν μετά από επεξεργασία των ψηφιοποιημένων 

υψομετρικών δεδομένων με το Arcmap 10. (Πηγή Μιμίδου Χ.«Διερεύνηση περιβαλλοντικών και 

ανθρωπογενών επιπτώσεων της πυρκαγιάς του 2012 στη νήσο Χίο με χρήση τηλεπισκόπησης και 

GIS). 
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Εικόνα6. Μορφολογικός χάρτης της νήσου Χίου. 

 

Έδαφος 

  Η εδαφική δομή της Χίου κατά κύριο λόγο ακολουθεί την γεωλογική δομή. Το σύνολο των 

εδαφών του νησιού είναι ασβεστολιθικής προέλευσης λόγω της έντονης παρουσίας των 

ασβεστολιθικών πετρωμάτων. Στο κεντρικό τμήμα του νησιού στα όρη Αίπος και Πελληναίο ο 

εδαφικός ορίζοντας είναι ελάχιστα ή καθόλου ανεπτυγμένος λόγω της έντονης παρουσίας 

βραχωδών ασβεστολιθικών μαζών. Στο βόρειο και το νότιο τμήμα οι εδαφικοί ορίζοντες 

παρουσιάζουν σχετικά μεγαλύτερη ανάπτυξη και η προέλευση τους είναι κατά κύριο λόγο από 

την αποσάθρωση ασβεστολιθικών πετρωμάτων και τριτογενών αποθέσεων και δευτερογενώς 

από την αποσάθρωση σχιστολιθικών και ηφαιστειακών πετρωμάτων. Συγκεκριμένα στην 

περιοχή μελέτης στη Βέσσα Χίου κοντά στην περιοχή των Μαστιχοχωρίων σε ποσοστό 

μεγαλύτερο του 70% τα εδάφη είναι αβαθή ασβεστολιθικής προέλευσης με λίγη έως καθόλου 

χαραδρωτή διάβρωση και χαμηλές έως μέτριες κλίσεις επιφανείας.  
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Ψηφιακό Μοντέλο Εδάφους (DEM) 

Η γήινη επιφάνεια ως γνωστόν παρουσιάζει πολλά διαφορετικά σχήματα και μορφές, όπως 

βουνά, λόφους, πεδιάδες, χαράδρες, κ.α., τα οποία διαφέρουν από περιοχή σε περιοχή και 

εκφράζουν στο σύνολό τους το ανάγλυφο. Το ανάγλυφο είναι επομένως ένα χαρακτηριστικό 

τριών διαστάσεων του οποίου όμως η αναπαράστασή του σε ένα χαρτί ή μία οθόνη δύο 

διαστάσεων παρουσιάζει αρκετές δυσκολίες. Από την άλλη πλευρά όμως η παρουσίαση του 

σχήματος ή της μορφής της επιφάνειας είναι θεμελιώδους σημασίας για πολλές εφαρμογές. 

Καθίσταται προφανές ότι η διαχείριση και επεξεργασία του ανάγλυφου καταλαμβάνει μία 

σημαντική θέση στα συστήματα Γεωπληροφόρησης και ειδικότερα στη χαρτογράφηση της 

γήινης επιφάνειας. Τα τελευταία χρόνια, τα ψηφιακά μοντέλα αναγλύφου έχουν καταστεί μια 

πολύ σημαντική παράμετρος σε όλα τα Γεωγραφικά Συστήματα Πληροφοριών και τα 

περισσότερα από αυτά περιλαμβάνουν κατάλληλους αλγόριθμους για την επεξεργασία των 

υψομετρικών τιμών, αναπαριστώμενες με μορφή αναλογική και ψηφιακή. 

Ένα Ψηφιακό Υψομετρικό Μοντέλο (Digital Elevation Model - DEM) αποτελεί μια ψηφιακή 

αναπαράσταση του γήινου ανάγλυφου, η οποία περιγράφει την γεωμετρία της γήινης επιφάνειας. 

Οι υψομετρικές μεταβολές της επιφάνειας, π.χ. το εδαφικό ανάγλυφο, μπορούν να περιγραφούν 

μαθηματικά με τη συνάρτηση του υψομέτρου σε σχέση με τη θέση του. Η θέση του μπορεί να 

οριστεί τόσο με γεωγραφικές συντεταγμένες (φ,λ) όσο και με ορθογώνιες συντεταγμένες (Χ,Υ) 

σε μία χαρτογραφική προβολή. Για να δημιουργηθεί ένα ψηφιακό μοντέλο ανάγλυφου είναι 

απαραίτητη η εισαγωγή των κατάλληλων δεδομένων σε ένα ΓΠΣ. Στη συγκεκριμένη διατριβή η 

μέθοδος που χρησιμοποιήθηκε για τη δημιουργία του DEM ήταν η χαρτογραφική ψηφιοποίηση. 

Σύμφωνα με αυτή τη μέθοδο, ο τοπογραφικός χάρτης (αναλογική μορφή) μετατρέπεται σε 

ψηφιακή μορφή. Η εισαγωγή των δεδομένων έγινε μέσω της ψηφιοποίησης, ενώ η επιλογή της 

ισοδιάστασης των ισοϋψών καθορίζεται από τον χρήστη ανάλογα με την κλίμακα του χάρτη, την 

κλίση του εδάφους και τον σκοπό της μελέτης. Η ακρίβεια του DEM εξαρτάται σε σημαντικό 

βαθμό από την λεπτομέρεια των ισοϋψών που χρησιμοποιούνται και από την κλίμακα του 

τοπογραφικού χάρτη από τον οποίο ψηφιοποιήθηκαν οι ισοϋψείς. Όσο μεγαλύτερη είναι η 

κλίμακα του τοπογραφικού χάρτη και όσο μικρότερη η ισοδιάσταση των ισοϋψών τόσο πιο 

ακριβές θα εμφανίζεται το DEM (Stefanovic 1988, Wise 1998). Το DEM είναι η πιο κοινή 

μέθοδος για την εξαγωγή περεταίρω πληροφοριών που αφορούν την τοπογραφία, τις 

μορφομετρικές παραμέτρους, τα γεωλογικά χαρακτηριστικά, τις μετακινήσεις - ολισθήσεις 

πρανών κλπ. (Hutchinson 1988, Cadell 2002, Kamp et al. 2003, Gelabert et al. 2005) 
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Διάγραμμα ροής της προεπεξεργασίας των δεδομένων ανάγλυφου SRTMDEM και 

της εξαγωγής των παράγωγων προϊόντων. Η διαδικασία ολοκλήρώθηκε στο Αrc 

 GIS 
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Εικόνα 7. Χάρτης Ψηφιακού Υψομετρικού Μοντέλου DEM) της νήσου Χίου 
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Εικόνα 8. Χάρτης μορφολογικών κλίσεων της νήσου Χίου. 
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Εικόνα 9. Χάρτης προσανατολισμού των κλίσεων της νήσου Χίου. 
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Εικόνα 10. Χάρτης λεκανών απορροής και υδρογραφικού δικτύου της νήσου Χίου. 
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  Δάσος πεύκης μετά από πυρκαγιά 

 

Άκαυτοι θύλακες. 

 

     Καμένα μαστιχόδενδρα. 
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Ζώνες Βλάστησης  

 

 

Η νήσος Χίος βρίσκεται στην Μεσογειακή (Θερμομεσογειακή) ζώνη βλάστησης. Η ζώνη 

αυτή εμφανίζεται σε μια σχεδόν συνεχή λωρίδα κατά μήκος των ακτών της Δυτικής, 

Νοτιοανατολικής και Ανατολικής Ελλάδας, έως τον Όλυμπο και τα Πιέρια Όρη, τα νησιά του 

Ιονίου και Αιγαίου Πελάγους, τα Δωδεκάνησα, την Κρήτη, τη χερσόνησο της Χαλκιδικής και 

κατά μήκος των ακτών της Μακεδονίας και της Θράκης. Το υψόμετρο στο οποίο συναντάται 

κυμαίνεται από 100-300 m στη Βόρεια Ελλάδα και φθάνει έως τα 1.000 - 1.500 m στα όρη της 

Κρήτης.  

Το κλίμα που επικρατεί στη ζώνη αυτή είναι καθαρά μεσογειακό (ευμεσογειακό), με εαρινό-

φθινοπωρινές και χειμερινές βροχοπτώσεις, θερμά καλοκαίρια και ήπιους σχετικά χειμώνες. Η 

ξηρή περίοδος κυμαίνεται από 2-3 μήνες στη Βορειοανατολική Ελλάδα έως 6 μήνες (Αττική, 

Ανατολική Κρήτη, Κυκλάδες). Στη μεσογειακή ζώνη, λόγω του ήπιου κλίματος και της εύκολης 
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πρόσβασης προς τις θαλάσσιες οδούς, αναπτύχθηκαν σπουδαίοι πολιτισμοί όπως ο Μινωικός, ο 

Κυκλαδικός, ο Μυκηναϊκός, αλλά και το σύνολο των μεγάλων πόλεων της χώρας, καθώς σχεδόν 

το 80% του πληθυσμού κατοικεί στη ζώνη αυτή, με αποτέλεσμα την πρώιμη καταστροφή και 

υποβάθμιση των δασών της, η οποία συνεχίζεται έως και σήμερα.  

Τα δάση της συγκεκριμένης ζώνης διακρίνονται, γενικά, σε δάση ή θαμνώνες αείφυλλων 

πλατύφυλλων (δάση φοινίκων, δάση και θαμνώνες αγριελιάς, χαρουπιάς και σχίνου, δάση αριάς, 

κουμαριάς, δάφνης και ρεικιού, δάση και θαμνώνες πουρναριού) και σε δάση μεσογειακών 

κωνοφόρων (δάση αρκεύθων, χαλεπίου και τραχείας πεύκης, κουκουναριάς, κυπαρισσιού). Τα 

δάση των αείφυλλων πλατύφυλλων έχουν υποβαθμιστεί στο μεγαλύτερο τμήμα τους σε 

υψηλούς, κλειστούς ή χαμηλούς, αραιούς θαμνώνες και σε φρύγανα. Αντίθετα, τα δάση των 

μεσογειακών κωνοφόρων διατηρούνται σε σχετικά καλή κατάσταση, παρά τις πιέσεις που 

δέχονται λόγω ανθρωπογενών δραστηριοτήτων. 

 

Μαστιχόδενδρα 

 Η καλλιέργεια του μαστιχόδεντρου (Pistacia lentiscus var. Chia) είναι στενά συνδεδεμένη   

με το νησί της Χίου και μάλιστα με το νότιο τμήμα του νησιού, το οποίο είναι ιδιαίτερα θερμό 

και ξηρό.  

Προσπάθειες να επεκταθεί η καλλιέργεια πέρα από το όριο αυτό απέτυχαν. Η αιτία για τη 

μοναδικότητα αυτή οφείλεται πιθανόν, εκτός από τη μακρόχρονη παράδοση και στα  

χαρακτηριστικά του εδάφους και του κλίματος της νότιας Χίου, τα οποία και ευνοούν την 

καλλιέργεια του φυτού μόνο εκεί.  

Το μαστιχόδεντρο αναπτύσσεται αργά και η πλήρης ανάπτυξή του επέρχεται στα 40-50 έτη. 

Ζει πάνω από 100 χρόνια αλλά μετά τα 70 χρόνια αρχίζει η παρακμή.  Η παραγωγή μαστίχας 

ξεκινά μετά από το 5
ο
-6

ο
 έτος του δέντρου ενώ η μέγιστη παραγωγικότητά  του επιτυγχάνεται 

στην ηλικία των 10-15 ετών. Η μέση ετήσια απόδοση μαστίχας ανά δέντρο είναι  150-180 gr. 

Ξεκινάει σε μικρή ηλικία με 7-13 gr και φτάνει τα 130-200 gr. Υπάρχουν ωστόσο και  σπάνιες 

περιπτώσεις  δέντρων που παράγουν δύο κιλά και άλλα που παράγουν 10 μόνο γραμμάρια. 

Περίπου 35.000  μαστιχόδεντρα 3,95 % σε ποσοστό καταστράφηκαν από τα 885.000 που 

προϋπήρχαν στο νησί πριν   απο την πυρκαγιά του 2016 σύμφωνα με τον συνεταιρισμό των 

μαστιχοπαραγωγών  Χίου.  

(35.000 / 885.000)* 100 = 3.95%. 
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Σχίνος – Μαστιχόδεντρο 
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Οι πυρκαγιές στη νήσο Χίο 

 Μέσος όρος του αριθμού των δασικών πυρκαγιών σε κάθε νομό για τα έτη 1976 - 1994. 

(Πηγή: στοιχείων Καϊλίδης) 

 

 

  Από τα στατιστικά στοιχεία προκύπτει ότι οι νομοί στους οποίους έχουμε τη   μεγαλύτερη 

καιόμενη έκταση ανά πυρκαγιά είναι: Χίου (1.445,8στρ.), Δωδεκανήσου (990,4 στρ.), Λασιθίου 

(920,1 στρ.), Καβάλας (903,7στρ.) και Λαρίσης (640στρ.), δηλαδή σε απομακρυσμένες περιοχές 

της χώρας. Όπου σύμφωνα με το Μαρκάλα (1992), τα αεροπλάνα αργούν να φτάσουν από τη 

βάση τους (Ελευσίνα). 
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Ανασκόπηση των πυρκαγιών της Χίου 

Σύμφωνα με στοιχεία της μελέτης του Ινστιτούτου Μεσογειακών Δασικών Οικοσυστημάτων 

και Τεχνολογίας Δασικών Προϊόντων (ΙΜΔΟ & ΤΔΠ), του ΕΘΙΑΓΕ και του WWF Ελλάς 

(Τσαγκάρη κ.α. 2011) και της μελέτης οικολογικού απολογισμού της πυρκαγιάς της Χίου το 

2012 του WWF Ελλάς (Κορακάκη κ.α., 2012), η Περιφερειακή Ενότητα (ΠΕ) Χίου 

κατατάσσεται δεύτερη (μετά την ΠΕ Δωδεκανήσου) μεταξύ των ΠΕ του γεωγραφικού 

διαμερίσματος των νησιών του Αιγαίου με βάση τις καμένες εκτάσεις, που αντιστοιχούν στο 

24% του διαμερίσματος, και τρίτη με βάση τον αριθμό των περιστατικών, τα οποία αντιστοιχούν 

στο 18% του διαμερίσματος.  

Συνολικά η έκταση των καμένων εκτάσεων για τη χρονική περίοδο 1983-2005 ανερχόταν σε 

302.555 στρ. και ήταν το αποτέλεσμα 446 πυρκαγιών, ενώ η μέση έκταση καμένης έκτασης ανά 

περιστατικό νομού ανέρχεται στα 678 στρ. Κατά μέσο όρο ετησίως στο νησί εκδηλώνονται 19 

περίπου φαινόμενα και καίγονται 13.155 στρ δασικών και γεωργικών εκτάσεων. Από τα 

καταγεγραμμένα στοιχεία για την περίοδο 1983-2005, προκύπτει ότι το 77,1% των εκτάσεων 

που κάηκαν ήταν δασικές και το 22,9% γεωργικές. Στο Σχήμα 6 παρακάτω παρουσιάζονται οι 

καμένες εκτάσεις ανά τύπο βλάστησης στο διάστημα 1983-2005. (Κορακάκη, 2012) 

 

 

 

 

 

 

 

 

 

Καμένες εκτάσεις ανά τύπο βλάστησης στην ΠΕ Χίου το διάστημα 1983-2005 

(Πηγή Κορακάκη, 2012) 
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Σύμφωνα με τις ίδιες μελέτες προκύπτει ότι το 2012 ήταν το έτος με τις μεγαλύτερες καμένες 

εκτάσεις (>148.000 στρ.) της τελευταίας τριακονταετίας. Τα αμέσως επόμενα καταστρεπτικά έτη 

ήταν το 1988 και το 1987, οπότε και οι καμένες εκτάσεις ανήλθαν σε 83.670 και 48.196 στρ. 

αντίστοιχα. Το 1987 συγκεκριμένα αποτεφρώθηκαν 30.700 στρ. πευκοδάσους τα οποία και 

κηρύχθηκαν αναδασωτέα. Η φωτιά του 2000 αποτέφρωσε 15.750 στρ. από τα οποία 9.890 στρ.  

αντιστοιχούσαν σε δασικές εκτάσεις, οι οποίες κηρύχθηκαν αναδασωτέες. Στο διάγραμμα 1 

παρατίθενται οι καμένες εκτάσεις ανά έτος. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Institutional Repository - Library & Information Centre - University of Thessaly
03/06/2024 03:54:29 EEST - 3.15.15.125



 

46 
 

Σύμφωνα με τα γενικά στοιχεία που αναλύθηκαν ως σημαντικοί παράγοντες, που επηρεάζουν 

το φαινόμενο των πυρκαγιών μπορούμε να εξάγουμε μερικά χρήσιμα συμπεράσματα για τις 

πυρκαγιές στο νησί της Χίου. Έτσι λοιπόν μπορούμε να πούμε: 

 Παρατηρείται μια αυξητική τάση στον αριθμό των δασικών πυρκαγιών στη Χίο (όπως 

και στην υπόλοιπη Ελλάδα) τα τελευταία χρόνια. Αντίθετα ο αριθμός των καμένων στρεμμάτων 

αυξάνει αλλά χωρίς να ακολουθεί την ίδια πορεία με τον αριθμό των πυρκαγιών, 

παρουσιάζοντας συνεχείς αυξομειώσεις. 

 Τα αίτια των πυρκαγιών στη Χίο που είναι γνωστά ανέρχονται σε ένα ποσοστό 65% με 

το ποσοστό που οφείλεται σε κακόβουλες ενέργειες (εμπρησμούς) να ανέρχεται στο 5% και στη 

καύση των χόρτων στο 27%. 

  Υπάρχει μια αύξηση των οικιστικών περιοχών και στα βοσκοτόπια, οι καλλιεργούμενες 

εκτάσεις παραμένουν στα ίδια επίπεδα ενώ τα δάση έχουν μειωθεί. Η αύξηση των βοσκοτόπων 

οφείλεται στην εγκατάλειψη των γεωργικών εκτάσεων κυρίως στο βόρειο τμήμα του νησιού 

καθώς και στην μετατροπή των δασικών εκτάσεων σε βοσκοτόπια. Η γεωργική γη παραμένει 

σταθερή λόγω της ενασχόλησης του πληθυσμού στο νότιο μέρος του νησιού με την καλλιέργεια 

της μαστίχας. 

 Ο μεγαλύτερος αριθμός των πυρκαγιών παρατηρείται στις δημοτικές ενότητες 

Καρδαμύλων και Μαστιχοχωρίων, δηλαδή στο Βορειοανατολικό και στο νοτιοδυτικό τμήμα του 

νησιού ενώ ο μικρότερος αριθμός των πυρκαγιών παρατηρείται στα νησιά Οινούσσες και Ψαρά 

και στις δημοτικές ενότητες Αγ. Μηνά και Ιωνίας, γεγονός που ταυτίζεται και με τις ζώνες 

επικινδυνότητας που δίνει η Πυροσβεστική Υπηρεσία. 

 Υπάρχει ένα μάλλον ευρύ χρονικό πεδίο εμφάνισης των δασικών πυρκαγιών σε επίπεδο 

έτους με μέγιστο αριθμό πυρκαγιών το μήνα Σεπτέμβρη και καταστρεπτικότερο από πλευράς 

καμένων στρεμματικών εκτάσεων τον μήνα Ιούλιο, κάτι που απαιτεί καλή και σταθερή 

οργάνωση αντιπυρικής προστασίας στο μεγαλύτερο διάστημα του έτους και ιδιαίτερα τα 

Σαββατοκύριακα που παρατηρείται και ο μεγαλύτερος αριθμός πυρκαγιών. 

 Ως προς το είδος των καμένων εκτάσεων είδαμε ότι κυριαρχούν οι πυρκαγιές σε 

φρυγανικές και χορτολιβαδικές περιοχές, ακολουθούν τα δάση και τέλος οι αγροτικές και 

καλλιεργήσιμες περιοχές. 

 Υπάρχει μια ισορροπία ως προς το ιδιοκτησιακό καθεστώς με μια ελαφριά υπεροχή των 

δημόσιων έναντι των ιδιόκτητων εκτάσεων. 
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3.3 Επεξεργασία και Ανάλυση Δορυφορικών Δεδομένων SENTINEL 2  

 

Συλλογή Δεδομένων και Προεπεξεργασία.  

Η προεπεξεργασία των εικόνων αφορά όλα τα προπαρασκευαστικά βήματα που είναι 

απαραίτητα για την βελτίωση της ποιότητας των αρχικών εικόνων. Αποτελεί ένα από τα πιο 

σημαντικά στάδια της ψηφιακής επεξεργασίας και θα πρέπει να γίνεται πολύ προσεκτικά διότι 

επηρεάζει σε μεγάλο βαθμό τα επόμενα στάδια, όπως είναι η ανάλυση της εικόνας. Στην 

παρούσα εργασία τα βήματα της προεπεξεργασίας αφορούν αρχικά την ατμοσφαιρική διόρθωση. 

 

1) Ατμοσφαιρική διόρθωση 

 Η ακτινοβολία που επιστρέφει στο διάστημα και καταγράφεται από τον δορυφορικό 

αισθητήρα επηρεάζεται από την επιφάνεια ανάκλασης και από τα συστατικά της ατμόσφαιρας τα 

οποία μεταβάλλονται στον χωρο-χρόνο (Huang et al., 2016; Καρτάλης and Φείδας, 2006, Αρχές 

και εφαρμογές της δορυφορικής τηλεπισκόπησης). Η πολλαπλή σκέδαση της ανακλώμενης 

ακτινοβολίας μεταξύ της επιφάνειας και της ατμόσφαιρας εισάγει μία εξάρτηση μεταξύ της 

ανάκλασης επιφάνειας και της συνεισφοράς της ατμόσφαιρας στην TOA (topofatmosphere - 

κορυφή της ατμόσφαιρας) ανάκλαση (Huang et al., 2016). Η έντονη σκέδαση της ορατής 

ακτινοβολίας από την ατμόσφαιρα έχει σαν αποτέλεσμα την αύξηση των κατώτερων τιμών στα 

κανάλια του ορατού, ιδιαίτερα στα μικρότερα μήκη κύματος δίνοντας μία ομιχλώδη εμφάνιση 

στην εικόνα (haze). Με την ατμοσφαιρική διόρθωση διορθώνεται η ατμοσφαιρική σκέδαση αλλά 

και η ατμοσφαιρική απορρόφηση η οποία εξαρτάται, σε μεγάλο βαθμό, από το ποσό των 

υδρατμών, την ποσότητα και κατανομή τους (Καρτάλης and Φείδας, 2006, Αρχές και εφαρμογές 

της δορυφορικής τηλεπισκόπησης).  

Για την υλοποίηση της ατμοσφαιρικής διόρθωσης και την μετατροπή των Sentinel 2 L1C 

προϊόντων, με μετρούμενη ανακλαστικότητα στην κορυφή της ατμόσφαιρας, σε L2A προϊόντα, 

με μετρούμενη ανακλαστικότητα κάτω από την ατμόσφαιρα – ανακλαστικότητα επιφανείας, 

χρησιμοποιήθηκε τo λογισμικό SNAP6.0.0 (esa-snap_all_windows-x64_6_0) και ο 

επεξεργαστής Sen2Cor6.0.0., ο οποίος είναι πλέον ενσωματωμένος στην πλατφόρμα του 

snap. Η έκδοση αυτή έτρεξε σε λειτουργικό σύστημα Windows 7 (64 bit). Επίσης, η εφαρμογή 

Sen2Cor λειτουργεί πλέον στο snap χωρίς την ομπρέλα του πακέτου Anaconda (Python 2.7).  
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Μετά την εγκατάσταση του προγράμματος snap στον Η/Υ, έγινε η εγκατάσταση των 

πρόσθετων  εργαλείων όπως του Sen2Cor από την γραμμή εντολών tools/plugins. Απαραίτητη 

προϋπόθεση για την εκτέλεση του  εργαλείου Sen2Cor είναι η δημιουργία φακέλου με το όνομα 

Sen2Cor μέσα στον Η/Υ στην διαδρομή C/χρήστες/ documents. 

Τα L2A προϊόντα δημιουργήθηκαν στην πλευρά του χρήστη, στον ίδιο φάκελο και ακριβώς 

από κάτω από τα L1C προϊόντα, με αλλαγή στην ονομασία του OPER σε USER και του L1C σε 

L2A και με το κάθε tile να έχει μέγεθος 600 MB. Οι φάκελοι στα L2A προϊόντα οργανώνονται 

διαφορετικά εξαιτίας του διαχωρισμού των φασματικών καναλιών σε φακέλους  10m, 20m και 

60m βάσει της διαφορετικής χωρικής ανάλυσης.  

Οι εικόνες που επιλέχθηκαν είναι οι : 

1. S2A_OPER_MSI_L1C_TL_MPS__20160617T125113_A005152_T35SMC_N02.04  

2. S2A_OPER_MSI_L1C_TL_MPS__20160727T125058_A005724_T35SMC_N02.04 

H ατμοσφαιρική διόρθωση έγινε μέσω της εντολής optical → Thematic Land Processing→ 

Sen2Cor→και  στο  processing parameters → resolution γράφουμε 20 m. 

 

Με την ίδια διαδικασία έγινε η ατμοσφαιρική διόρθωση των καναλιών με ανάλυση 10 m.  

Δημιουργήθηκαν τα αρχεία: 

1) S2A_USER_MTD_L2A_TL_MPS__20160617T125113_A005152_T35SMC 

2) S2A_USER_MTD_L2A_TL_MPS__20160727T125058_A005724_T35SMC 

Τα οποία έχουν κανάλια με ανάλυση στα 20m και 10 m 

Η ανάλυση της ατμοσφαιρικής διόρθωσης προηγείται όλων των άλλων ενεργειών στο  

πρόγραμμα SNAP. 
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 Στη συνέχεια με τη βοήθεια του προγράμματος SNAP, επιλέγουμε το open product, 

βρίσκουμε το  αρχείο:  

S2A_USER_MTD_L2A_TL_MPS__20160617T125113_A005152_T35SMC.SAFE→GRANUL 

E →......→ open. Ανοίγουμε το αρχείο, το επιλέγουμε και με δεξί κλικ επιλέγουμε την εντολή 

Open RGB Ιmage Window. 

 

Στο παράθυρο του Open RGB Ιmage Window επιλέγουμε τα κανάλια B12, B11 και B8Α 

(Red: B12, Green: B11 ,Blue: B8A) και οκ. Θα μπορούσαμε να τις απεικονίσουμε  σε true 

(natural) colours, αλλά για να διακρίνουμε τις καμένες περιοχές, είναι προτιμότερο να 

χρησιμοποιούμε τις ζώνες Near Infrared (NIR) και Short Wave Infrared (SWIR), καθώς με αυτές 

διαχωρίζεται καλύτερα η καμένη επιφάνεια από την άκαυτη. 

Το προϊόν εισόδου περιέχει 13 κανάλια (φασματικές ζώνες) με 2 διαφορετικές χωρικές 

αναλύσεις. Όταν ανοίγουμε την προβολή RGB οι ζώνες εισόδου μας έχουν ανάλυση 20 m, 

ωστόσο, η προβολή εμφανίζεται στην πλήρη ανάλυση των 10 m. 
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Η ίδια διαδικασία εφαρμόζεται και για το αρχείο   

S2A_USER_MTD_L2A_TL_MPS__20160727T125058_A005724_T35SMC. 
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Ανοίγουμε και τα δύο αρχεία στο πρόγραμμα, στη συνέχεια επιλέγουμε την εντολή Window -

>Tile Horizontally, αφού πρώτα τσεκάρουμε το   και το . Με αυτό τον τρόπο έχουμε τις 

δύο  εικόνες πριν και μετά την πυρκαγιά στην επιφάνεια εργασίας. 
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Στη συνέχεια επιλέγουμε ένα από τα δύο αρχεία και επιλέγουμε την εντολή Raster → 

Geometric Operation → Resampling, στις παραμέτρους επιλέγουμε το κανάλι Β2 ( ανάλυση 

10m) ώστε όλα τα κανάλια (Bands) να έχουν την ίδια ανάλυση των 10m→RUN→ επεξεργάζεται 

την εντολή και close. 
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Το αρχείο που εμφανίζεται έχει το ίδιο όνομα με το αρχείο που είχαμε επιλέξει με τη μόνη 

διαφορά  ότι έχει προστεθεί στο τέλος το resampled, αποτελεί προεπισκόπηση και δεν 

αποθηκεύεται ακόμη στον υπολογιστή μας.  

Στη συνέχεια επιλέγοντας το νέο αρχείο που προέκυψε δίνουμε την εντολή 

resampled→raster→subset, κόβουμε την εικόνα στην περιοχή που θα μελετήσουμε → 

επιλέγουμε τα κανάλια που μας ενδιαφέρουν από το Band Subset→  οκ. 

 

 

 

Την ίδια διαδικασία εφαρμόζουμε και για το άλλο αρχείο  

S2A_USER_MTD_L2A_TL_MPS__20160727T125058_A005724_T35SMC., ώστε τα δύο 

προϊόντα  να έχουν το ίδιο ακριβώς μέγεθος pixel και να αποτυπώνουν την ίδια ακριβώς περιοχή. 

α)subset_4_of_S2A_USER_MTD_L2A_TL_MPS__20160617T125113_A005152_T35SMC_res

ampled (α) 

β)subset_5_of_S2A_USER_MTD_L2A_TL_MPS__20160727T125058_A005724_T35SMC_res

ampled (β) 

Τα δύο προϊόντα τα επιλέγουμε και τα αποθηκεύουμε με την εντολή file→save product. 
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3) Δημιουργία cloud mask 

 

Το προϊόν Sentinel-2 L2-A περιέχουν vector cloud και cirrus masks, οι οποίες δημιουργούνται 

ως προϊόν της ατμοσφαιρικής διόρθωσης, όμως η εφαρμογή της μάσκας σε όλα τα κανάλια και η 

πλήρης διαδικασία απαιτεί κάποιο χρόνο. Για να διατηρήσουμε λοιπόν τις πληροφορίες, 

δημιουργούμε μια νέα ζώνη που περιέχει μια μάσκα σύννεφων.  

Η διαδικασία προσθήκης της μάσκας cloud_mask γίνεται σε κάθε προϊόν (1) και (2) χωριστά. 

Κάνουμε δεξί κλικ στο πρώτο ανοιχτό προϊόν και κλικ στην εντολή Band Maths. Ανοίγει ένα νέο 

παράθυρο. Ορίζουμε ως όνομα : cloud_mask. Αποεπιλέγουμε με τοVirtual (safe expression only, 

don’t store data), στη συνέχεια κάνουμε κλικ στην επιλογή Edit Expression… και εισαγάγουμε 

την ακόλουθη πρόταση: if (scl_cloud_medium_proba + scl_cloud_high_proba + 

scl_thin_cirrus) < 255 then 1 else 0 

 

 

 

   Το νέο BAND ανοίγει αυτόματα σε μια νέα προβολή. Μπορούμε να κάνουμε κλικ στην 

καρτέλα ονομάτων προβολής και να μεταφέρουμε το παράθυρο προβολής στην κατάλληλη 
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προβολή RGB.  Στην καρτέλα Πλοήγηση να κάνουμε κλικ στο Zoom All. Κάνουμε το ίδιο για 

τα προϊόντα μετά την πυρκαγιά και προβάλουμε τα δύο προϊόντα στην επιφάνεια όπως 

παρακάτω. 

 

 

 

 

4) Mάσκα  land/sea 

Πριν ξεκινήσουμε την επεξεργασία ταυτόχρονα των δύο προϊόντων, θα βάλουμε μάσκα ώστε 

να  απομακρύνουμε τη θάλασσα και να αποφύγουμε τις οποιεσδήποτε παρεμβολές της στις 

μετέπειτα διαδικασίες. Επιλέγουμε το προϊόν, κλικ στην εντολή raster → masks → land/sea 

mask στη συνέχεια  επιλέγουμε που θα αποθηκευτεί το αρχείο και το όνομά του με την κατάληξη 

msk→ στις  παραμέτρους επιλέγουμε mask out land → RUN και close. 
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5) Subset –Επιλογή καναλιών 

Για την καλύτερη και πιο γρήγορη επεξεργασία επιλέγουμε τα δύο αρχεία που προηγουμένως   

είχαμε αποθηκεύσει και με το εργαλείο subset (όπως προαναφέραμε) επιλέγουμε μόνο τα  

κανάλια B3,B8,B12 και cloud_mask και αποθηκεύουμε.  

 

6)  Επεξεργασία Δεδομένων και Δημιουργία Δεικτών. 

Normalized Burn Ratio (NBR) 

Στη συνέχεια, με το εργαλείο Band Maths σε καθένα από τα δύο προϊόντα, ορίζουμε την  

έκφραση  για τον υπολογισμό του Normalized Burn Ratio (NBR).  
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Target band: NBR  

No-Data Value: NaN  

Expression: (B8–B12)/(B8+B12) 

 

 

 

7) Δημιουργία Γραφήματος Graph Builder και Batch Processing 

Στη συνέχεια για την περαιτέρω επεξεργασία των δεδομένων μπορούμε να χρησιμοποιήσουμε 

το  εργαλείο Batch Processing για να επεξεργαστούμε ταυτόχρονα τα προϊόντα πριν και μετά 

την  πυρκαγιά. Για να χρησιμοποιήσουμε το εργαλείο πρέπει πρώτα να ορίσουμε τη 

διαδικασία που  θέλουμε να εφαρμόσουμε καθώς και όλα τα βήματα του. Μπορούμε να το 

κάνουμε αυτό χρησιμοποιώντας το εργαλείο Graph Builder. Με το Graph Builder δεν θα 

αποθηκευτεί κανένα  ενδιάμεσο προϊόν παρά μόνο το τελικό προϊόν. Φτιάχνουμε το γράφημά 

ως εξής: Επιλογή αρχείου->Tools ->Graph Builder. 
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Στην αρχή το γράφημα έχει μόνο Read (to read the input) and Write (to write the output).Με 

δεξί κλικ στο άσπρο φόντο επιλέγουμε Add→Raster→BandMerge και με αριστερό κλικ 

συνδέουμε αυτά (READ  κ.λπ.) μεταξύ τους  ή με δεξί κλικ επιλέγουμε Connect Graph, όπως 

παρακάτω: 

 

Αποθηκεύουμε  το γράφημα  στη θέση: C/Χρήστες/.snap/graphs/User Graphs με το όνομα my 

graphs ή Graph_process.xml έπειτα save και close. Στο Product Explorer, επιλέγουμε το προϊόν 

του Ιουνίου 2016. Στη συνέχεια κλείνουμε το  παράθυρο Graph Builder και ανοίγουμε το 

εργαλείο (Tools ->Batch Processing). Στη συνέχεια προσθέτουμε  και τα δύο ανοιγμένα 

προϊόντα κάνοντας κλικ στο Add Opened, Προσθήκη στο πάνω δεξιά  (δεύτερο από το επάνω 

μέρος) και κάνουμε κλικ στo refresh. Καταργoύμε την επιλογή Keep source product name. Στη 
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συνέχεια, κάνουμε κλικ στο κουμπί Load Graph στο κάτω μέρος του  παραθύρου, βρίσκουμε το 

αποθηκευμένο γράφημά μας και το ανοίγουμε.  

 

 

 

 

 

 

 

Επιλέγουμε RUN για να to τρέξουμε, μπορεί να διαρκέσει περίπου 7 λεπτά ανάλογα με το  

μηχάνημα και close. Τώρα, έχουμε δύο νέα προϊόντα στον Product Explorer. Στη συνέχεια  

κλείνουμε όλα τα προϊόντα και ανοίγουμε τα νέα.  

1.subset_0_of_subset_4_of_S2A_USER_MTD_L2A_TL_MPS__20160617T125113_A00515 

2_T3  

5SMC_resampled_msk_msk  και 

2. S2A_USER_MTD_L2A_TL_MPS__20160727T125058_A005724_T35SMC_resampled_msk 
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Στα κανάλια των προϊόντων(Band) κάνουμε διπλό κλικ στη ζώνη NBR. Το ίδιο κάνουμε και το 

άλλο προϊόν Ιουλίου. Μεταβαίνουμε  στο Παράθυρο ->Window ->Tile Horizontally και στην  

καρτέλα Navigation κάνουμε κλικ στο Zoom All. 

 

 

 

8) Collocation 

Τώρα θα συνδυάσουμε τα δύο προ-επεξεργασμένα προϊόντα έτσι ώστε να μπορούμε εύκολα 

να υπολογίσουμε την αλλαγή των τιμών NBR πριν και μετά την πυρκαγιά Μεταβαίνουμε στην  

επιλογή Raster -> Geometric Operations -> Collocation. Στα προϊόντα πηγής ορίζουμε το 

προϊόν   Ιουνίου ως Master και το προϊόν Ιουλίου ως Slave. 
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Στο Target Name: S2A_201706017_20170727 

Στο Renaming of Source Product Components αλλάζουμε το ${ORIGINAL_NAME}_June  

και  ${ORIGINAL_NAME}_July.  

Επιλέγουμε την θέση που θα αποθηκευτεί το αρχείο directory  στο ...........Click Run.  

Περιμένουμε να τρέξει η εφαρμογή και οκ → close . Ένα νέο σχέδιο δημιουργήθηκε στο 

 Product Explorer 
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9) Cloud Mask 

Για να αποκρύψουμε τα σύννεφα που συμβαίνουν στην εικόνα εισόδου, δημιουργούμε μια 

ενιαία  μάσκα νέφους.  Κάνουμε δεξί κλικ στο νέο δημιουργημένο προϊόν προϊόν 

S2A_201706017_20170727, επιλέγουμε  Band Maths και ρυθμίζουμε : Target band: 

cloud_mask, Expression: if (cloud_mask_June> 0 or cloud_mask_July>0) then 1 else 0, κλικ 

οκ και  δημιουργείται η μάσκα μέσα στο προϊόν.  
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10) BURNED AREAS AND BURN SEVERITY
1
 

Για τον εντοπισμό των πρόσφατα καμένων περιοχών και για τη διαφοροποίησή τους από το 

γυμνό  έδαφος και άλλες περιοχές που δεν έχουν βλάστηση, χρησιμοποιείται συχνά η διαφορά 

μεταξύ της  προ-πυρκαγιάς και της μετά την πυρκαγιά NBR, και ο δείκτης  (dNBR). 

    =      −    −        −     

Ωστόσο, το dNBR είναι μια απόλυτη διαφορά που μπορεί να παρουσιάσει προβλήματα σε 

περιοχές  με χαμηλή κάλυψη βλάστησης πριν από την πυρκαγιά, όπου η απόλυτη αλλαγή μεταξύ 

NBR πριν  την πυρκαγιά και μετά την πυρκαγιά είναι μικρή. Σε αυτές τις περιπτώσεις, η σχετική 

έκδοση της σοβαρότητας του καψίματος είναι συμφέρουσα. Σε αυτήν την εργασία 

χρησιμοποιούμε τον  αναλυτικό λόγο καύσης (RBR). 

 

 

Σε αυτό το βήμα εφαρμόζουμε τη μάσκα νέφους που έχουμε δημιουργήσει και δημιουργούμε 

νέο Band. Επιλέγουμε το αρχείο S2A_201706017_20170727 δεξί κλίκ BandMaths  και ορίζουμε 

: 

 

                                                             
      1Πηγή : https://rus-copernicus.eu/portal/wp-content/uploads/library/ education/training/ HAZA02_ 

BurnedArea_Portugal_Tutorial.pdf 
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Targetband: RBR 

Expression: if (cloud_mask == 0) then ((NBR_June – NBR_July)/(NBR_June + 1.001)) else 

NaN. Αποεπιλέγουμε το Deselect Virtual (save expression only, don’t store data)→οκ και 

πάλι οκ . 

 

 

 

Institutional Repository - Library & Information Centre - University of Thessaly
03/06/2024 03:54:29 EEST - 3.15.15.125



 

65 
 

 

 

Τα καμένα εικονοστοιχεία φαίνονται πολύ φωτεινότερα (κόκκινο χρωματισμό) καθώς η 

μεταβολή  μεταξύ των τιμών πριν και μετά την φωτιά είναι πολύ μεγαλύτερη. Τώρα θα 

δημιουργήσουμε ένα  νέο κανάλι που θα περιέχει μόνο με τις καμένες περιοχές. Θέτουμε ως 

κατώτατο όριο για να  ταξινομηθεί το εικονοστοιχείο ως καμένο στο> 0.09 

Με την ίδια διαδικασία κάνουμε κλικ στο αρχείο S2A_201706017_20170727,στη συνέχεια 

δεξί κλικ και BandMaths.  

Target band: RBR  

No-Data Value: NaN  

Expression: if $3.RBR >0.09 then $3.RBR else NaN 

Αποεπιλέγουμε  το  Virtual (save expression only, don’t store data)→ok→ok 
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11) Export as GeoTIFF 

Κλείνουμε όλα τα παράθυρα, στο Product Explorer επιλέγουμε (highlight) το αρχείο  

S2A_201706017_20170727, κλικ File ->Export ->GeoTiff (NOT! Geotiff/BigTiff). Στο 

παράθυρο διαλόγου που ανοίγει επιλέγουμε Subset ->Band Subset (second tab) και τσεκάρουμε 

μόνο τα κανάλια RBR and RBR_→click Ok και σώζουμε το αρχείο ως 

S2A_201706017_20170727_RBR.tif to the Processing folder. Στο παράθυρο διαλόγου  (No Flag 

Dataset Selected) click No. 

 

Τώρα μπορούμε να εισάγουμε την εικόνα σε άλλο λογισμικό GIS/Τηλεπισκόπησης για  

περαιτέρω επεξεργασία ή δημιουργία χαρτών.  Σε αυτήν  την  εργασία  χρησιμοποιούμε  το  

ArcMap 10.4.1. 
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11.Επεξεργασία στο ArcMap 10.4.1. 

Ανοίγουμε το arc gis και με κλικ στο Add Data εισάγουμε το αρχείο  

S2A_201706017_20170727.tiffτο οποίο δημιουργήσαμε. 

Για να μπορέσουμε να επεξεργαστούμε το αρχείο(στο Classified), το  επιλέγουμε και από το  

Arc Toolbox→Data Management Tools→Raster→Raster properties→calculate statistics,  

στο Environments επιλέγουμε το Greek Grid από το Output Coordinates και οκ. 

 

Με το τρόπο αυτό επεξεργαζόμαστε το αρχείο στο properties. Δεξί κλικ στο αρχείο 

επιλέγουμε το  properties  και προσπαθούμε να αλλάξουμε τις ιδιότητες επιλέγοντας το 

Classified.  
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Δημιουργούμε πέντε κλάσεις  και οκ. 

Στη συνέχεια δημιουργούμε ένα πολύγωνο/μάσκα (feature class) από το Data Management  

Tools→Feature Class→Create Feature Class το οποίο ονομάζουμε mask. 

 

 

 

Στη συνέχεια με το editor ή το Arc toolbox ψηφιοποιούμε ένα πολύγωνο γύρω από την  

καμένη  έκταση (create  new feature class polygon). 

Στη συνέχεια  επιλέγουμε το αρχείο →Arc Toolbox→Spatial Analyst Tools→extraction→  

Extract by mask, ώστε να απομακρύνουμε όλα τα εικονοστοιχεία γύρω από τη καμένη  

έκταση. 

 

 

 Mε το τρόπο αυτό δημιουργούμε ένα νέο αρχείο με το όνομα raster_mask. 
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Raster_ mask 

1. Για να επεξεργαστούμε πιο γρήγορα τις εικόνες δημιουργούμε ένα νέο Shapefile 

πολύγωνο  

2. (μάσκα)  επιλέγοντας toolboxes\system toolboxes\data management tools.tbx\feature  

class\create feature class. Επιλέγουμε την περιοχή που θα το αποθηκεύσουμε, γράφουμε το 

όνομα του αρχείου (mask), το είδος του αρχείου (polygon), διαλέγουμε το προβολικό 

σύστημα   (το οποίο θα πρέπει να είναι ίδιο με το προβολικό σύστημα που έχουν οι εικόνες)  

και ok.         
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3. Μετά τη δημιουργία του αρχείου mask, επιλέγoυμε με αριστερό κλικ του ποντικιού την 

εντολή     editor → start enditing → δημιουργούμε ένα πολύγωνο γύρω από την περιοχή που 

μας        ενδιαφέρει → το αποθηκεύουμε  με την εντολή save edits →stop editing.  

4. Η διαδικασία για το κόψιμο των εικόνων γίνεται με την εντολή  toolboxes\ system 

toolboxes  \spatial analyst tools.tbx\extraction\extract by mask.  

 

 

 

Επιλέγουμε την εικόνα που θα κόψουμε (π.χ. LE07_L1TP_184033_20160523_20161010_01_  

T1_B1) → βρίσκουμε επιλέγουμε το αρχείο που δημιουργήσαμε mask→ επιλέγουμε που θα  

αποθηκευτεί το νέο αρχείο και το νέο όνομα του αρχείου.   
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Με αυτό τον τρόπο απομακρύνουμε όλα τα δεδομένα που δεν μας χρειάζονται, γύρω από την  

καμένη έκταση.  Στη συνέχεια επιλέγουμε το αρχείο → Arc Toolbox→ Spatial Analyst Tools→ 

Reclass→Reclassify  και δημιουργούμε τρεις κλάσεις  στην καμένη έκταση σχετικά με το βαθμό 

καύσης της βλάστησης. 

 

 

 

 

Δημιουργήθηκε το αρχείο Reclass_rast5 . 
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Στη συνέχεια επιλέγουμε το Reclass_rast5, δεξί κλικ open attribute table, ανοίγουμε το 

πίνακα  από το table options κλικ στο Add Fields προσθέτουμε το πεδίο area, το οποίο το 

επιλέγουμε και δεξί κλικ επιλέγουμε το field calculate.  Λαμβάνοντας  υπόψη ότι  το cell size 

είναι 10 Χ 10  . 
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Βρίσκουμε ότι στο δείκτη χαμηλή έως μέτρια δριμύτητα η καμένη έκταση έχει  μεγάλο 

ποσοστό λόγω του χαμηλού ποσοστού δασοκάλυψης πριν την φωτιά, επειδή α) τμήμα της  

καμένης έκτασης είχε ξανακαεί το 2012 και β) τμήμα της έκτασης καλύπτονταν από αγροτικές 

καλλιέργειες με χαμηλό ποσοστό βλάστησης. Από τον αριθμό των αντίστοιχων pixels 

υπολογίζουμε την αντίστοιχη και την συνολική καμένη έκταση. 

 

Βαθμός Δριμύτητας Δείκτης Εμβαδόν (Ha) Ποσοστό(

%) 

Χαμηλή – Μέτρια 

Δριμύτητα  

0,09-0,27 1824,29 42,8 

Μέτρια – Υψηλή 

Δριμύτητα 

0,27-0,37 1164,28 27,32 

Υψηλή – Πολύ 

Υψηλή  Δριμύτητα 

0,37-0,85 1273,31 29,88 

Σύνολο  4.261,88 100 
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Επίσης με την εντολή Arc Toolbox→  Conversion Tools → From Raster → Raster to polygon  

→ 

 

Δημιουργούμε ένα αρχείο polygon.shp το οποίο θα χρησιμοποιήσουμε για την τοπογραφική  

διόρθωση  

 

   Τα πολύγωνα τα οποία προέκυψαν από την μετατροπή το raster to vector 
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12) Παρουσίαση αποτελεσμάτων στο GOOGLE EARTH 

 Η τοπογραφική διόρθωση συνιστά ένα σημαντικό βήμα στην προεπεξεργασία δορυφορικών 

δεδομένων και ιδιαίτερα σε περιπτώσεις ταξινόμησης της κάλυψης γης και ποσοτικής ανάλυσης 

σε πολυφασματικά δεδομένα καθώς οι επιδράσεις του ηλιακού φωτισμού μπορούν να 

προκαλέσουν διακυμάνσεις στην ανακλαστικότητα παρόμοιων οντοτήτων του εδάφους με 

αποτέλεσμα μία        πιθανή εσφαλμένη ταξινόμηση εξαιτίας των διαφορετικών τοπογραφικών 

θέσεων.Το αντίκτυπο αυτών των επιπτώσεων επηρεάζεται κυρίως από την τοπική ηλιακή γωνία 

πρόσπτωσης, το μήκος κύματος της εισερχόμενης ακτινοβολίας και την διαφορετική 

χαρακτηριστική ανακλαστικότητα κάθε οντότητας του εδάφους που χαρακτηρίζεται από  

διαφορετικό τύπο στην κάλυψη γης (Gaoetal., 2014; Tweleetal., 2006).  

Για την τοπογραφική διόρθωση χρησιμοποίησα το αρχείο polygon.shp , το μετέφερα στο 

πρόγραμμα Autodesk map 2016 και με την βοήθεια του αρχείου contour.shp (το οποίο έχει 

γεωαναφορά στο προβολικό σύστημα ΕΓΣΑ 87) έκανα την τοπογραφική διόρθωση, την 

μετατροπή του στο προβολικό σύστημα ΕΓΣΑ 87 και με την εντολή Export Dataαπό το  

Fileτην εισαγωγή του στο Google Earth Pro. 
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13) Διερεύνηση αναβλάστησης με τυχαία δειγματολειψία σε ένα σημείο. 

Ύστερα από τυχαία δειγματοληψία ο δείκτης NDVI στην συγκεκριμένη περιοχή μας δίνει 

τιμή 0,14 < 0,2 που σημαίνει ότι δεν έχουμε αναβλάστηση. Ο δείκτης βλάστησης της αριστερής  

εικόνας με  ημερομηνία λήψης15/09/2016, μετά την πυρκαγιά (Landsat 8 RGB 7.5.3). Ο δείκτης 

βλάστησης  της δεξιάς εικόνας με ημερομηνία λήψης 18/09/2017, 1 χρόνο μετά την πυρκαγιά. Η 

τιμή του  δείκτη NDVI στην συγκεκριμένη περιοχή μας διαμορφώνεται στην τιμή του 0,25 > 0,2 

γεγονός που σημαίνει ότι ίσως οριακά να αρχίζει σιγά σιγά να αναπτύσσεται βλάστηση σε μία 

περιοχή χαμηλής  έως μέτριας δριμύτητας. 

 

 

 

Εικόνα 37. Τυχαία δειγματοληψία στην πληγείσα περιοχή 

- 0.1 - 0.1  (Άκαυτο)

0.1 - 0.27  (Χαμηλή Δριμύτητα)

0.27 - 0.44  (Χαμηλή - Μέτρια Δριμύτητα)

0.44 - 0.66  (Μέτρια - Υψηλή Δριμύτητα) 

> 0.66  (Υψηλή - Πολύ Υψηλή Δριμύτητα)

15/09/2016 18/09/2017 
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1)  Κανονικοποιημένος δείκτης περιεχόμενης υγρασίας βλάστησης Normalized Difference  

2)  Moisture intex (NDMI) 

     Ο δείκτης NDMI: O κανονικοποιημένος δείκτης υγρασίας προέρχεται από τα κανάλια που  

βρίσκονται στα μήκη κύματος του εγγύς υπέρυθρου. Η μαθηματική σχέση του δείκτη είναι:  

 

NDΜI = (NIR -

SWIR)/(NIR+SWIR) 

 

Όπου NIR το εγγύς υπέρυθρο 1 κανάλι (5ο κανάλι) και SWIR (6ο κανάλι) το εγγύς υπέρυθρο 

2  κανάλι. Όπως αναφέρουν οι Horlerand Ahern (1986), τα κανάλια που συμβάλουν στη 

δημιουργία του  δείκτη, εξηγούν περισσότερο από όλα τα άλλα, τη δομή των δασών, ιδιαιτέρως 

των κωνοφόρων και φυλλοβόλων δασών. Ο κανονικοποιημένος δείκτης υγρασίας σχετίζεται σε 

μεγάλο βαθμό με φυτά όπου παρουσιάζουν μεγάλες τιμές υγρασίας στην κόμη τους. Επίσης ο 

δείκτης ανιχνεύει καλύτερα από τον κανονικοποιημένο δείκτη βλάστησης   τις αλλαγές στη 

φυτική βιομάζα και στις πιέσεις που δέχεται η βλάστηση από την έλλειψη νερού (Jinand Sader 

2005, Measurement of forest disturbance and regrowth with Landsat and Forest Inventory and 

Analysis Data). 
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Από την ανάλυση προκύπτει ότι μετά από ένα χρόνο τα αποτελέσματα της αναβλάστησης  

είναι φτωχά και θα απαιτηθεί νέος έλεγχος τα επόμενα χρόνια. 

 

14. Χρήσεις γης  καμένης έκτασης. 

 Αφού φορτώσουμε το CORINE στο Arc map ή τους χάρτες γλάστησης του ΥΠΕΝ, με την  

εντολή intersect παίρνουμε τα νέα πολύγωνα  με τους τύπους βλάστησης. 
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Εικόνα 11. Χάρτης καλύψεων γής Corine 2012. 
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Ταξινόμηση με τους χάρτες βλάστησης του ΥΠΕΝ 
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Η διαδικασία εξαγωγής αποτελεσμάτων παρουσιάζεται στις παρακάτω εικόνες. 
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Με το Atributes tables και το statistics υπολογίζουμε τα αντίστοιχα εμβαδά των εκτάσεων 

ανά   είδος βλάστησης που κάηκε, τα οποία παρουσιάζονται στον παρακάτω πίνακα: 

 

    Κύριοι τύποι κάλυψης γης, σύμφωνα με Corine land Cover. 

Τύπος κάλυψης Έκταση στρ. Ποσοστό % 

Γεωργικές Καλλιέργειες 8.020 18,82 

Μεικτές εκτάσεις 4.023 9,44 

Δάση Κωνοφόρων 1.879  4,31 

Χαμηλή-αραιή    

βλάστηση 

   652 1,53 

Αείφυλλα πλατύφυλλα 18.205 42,72 

Θαμνώνες 9.840 23,09 

ΣΥΝΟΛΟ 42.619  100 

\ 
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 ΄Έγινε ταξινόμηση της καμένης βλάστησης και από τους ψηφιοποιημένους χάρτες 

βλάστησης της    Γενικής Διεύθυνσης του ΥΠΕΝ, τα οποία παρουσιάζονται στον παρακάτω 

πίνακα: 

Κύριοι τύποι κάλυψης γης, σύμφωνα με τον Χάρτη βλάστησης του ΥΠΕΝ 

Τύπος κάλυψης Έκταση στρ. Ποσοστό % 

Δάση Κωνοφόρων    4.008     9,40 

Αείφυλλα πλατύφυλλα-   

θαμνότοποι 

  19.548   45,55 

Χορτολίβαδα    4.312  10,11 

Οικισμοί        53    0,12 

Γεωργικές Καλλιέργειες 14.698  34,49 

ΣΥΝΟΛΟ 42.619   100 

 

Για τον προσδιορισμό των διάφορων τύπων βλάστησης και τις καλύψεις γης στην περιοχή 

που επλήγη από τη φωτιά του Ιουλίου 2016, χρησιμοποιήθηκαν οι χρήσεις γης του Corine Land 

Cover 2012).  

Από ανάλυση των στοιχείων και με τη βοήθεια του πακέτου Arc GIS 10.4, προκύπτουν οι 

παρακάτω χρήσεις γης  για την καμένη έκταση των 43.469 στρ. Οι μόνιμες και σύνθετες 

καλλιέργειες αφορούν σε περιοχές με αγροτικό χαρακτήρα και κύριες καλλιέργειες από 

μαστιχόδενδρα και ελιά. Στα δάση κωνοφόρων συναντούμε αμιγή δάση θερμόφιλων κωνοφόρων 

τραχείας πεύκης (Pinus brutia). Στους θαμνώνες αειφύλλων-πλατυφύλλων συγκαταλέγονται 

είδηόπως το πουρνάρι (Quercus coccifera), ο σχίνος (Pistacia lentiscus), κ.α. Στην κατηγορία 

θαμνώνες εντοπίστηκαν κυρίως φρυγανικά είδη, όπως η λαδανιά (Cistus sp.), η αφάνα 

(Sarcopoterium spinosum), το χινοπόδι (Genista acanthoclada), ο ασπάλαθος (Calicotome 

villosa), η γαλαστοίβη (Euphorbia acanthothamnos). Αξίζει επίσης να αναφερθούμε και σε άλλα 

σημαντικά είδη χλωρίδας του υπορόφου που απαντώνται στη συγκεκριμένη περιοχή. Στην 

Ελλάδα 138 είδη χλωρίδας έχουν βρεθεί να συνδέονται άμεσα με την ύπαρξη παραδοσιακών 

μορφών γεωργίας (Bergmeier and Strid, 2014), όπως είναι η μαστιχοκαλλιέργεια. Καλλιέργειες 
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δηλαδή που δεν είναι εντατικές, δεν αρδεύονται και δεν υπόκεινται στην έντονη χρήση 

ζιζανιοκτόνων.  

Ειδικότερα στη Χίο, στα ξηρά εδάφη με φρύγανα και μαστιχόδεντρα στα νότια του νησιού, 

όπου εφόσον δεν ψεκάζονται με ζιζανιοκτόνα, εμφανίζονται πολλά ανθοφόρα είδη, 

συμπεριλαμβανομένων πολλών ορχιδέων, όπως  η σπάνια και ενδημική Ophrysregis-ferdinandii. 

Το ίδιο ισχύει και για το είδος τουλίπας (λαλάδα) Tulipa undulatifolia το οποίο επίσης 

αναφέρεται στη ευρύτερη περιοχή που επηρεάστηκε από την πυρκαγιά του Ιουλίου (Strid, 2016). 

Να σημειωθεί ότι το είδος αξιολογείται ως τρωτό (Phitosetal, 1995) και φυτρώνει νάμεσα σε 

πέτρες και ασβεστολιθικές πλαγιές, σε περιοχές με φρύγανα ή   αραιά δάση ή απαντάται σαν 

«ζιζάνιο» σε καλλιέργειες και εγκαταλελειμμένα χωράφια. Τα είδη  Tulipa agenensis και T. 

radii, επίσης φύονται σε καλλιέργειες και πιθανώς η εξάπλωσή τους να έχει επηρεαστεί οριακά 

από την πυρκαγιά, αν και κυρίως συναντώνται ανατολικότερα στο νησί. Να σημειωθεί ότι αν και 

τα είδη αυτά μπορεί να είναι τοπικά άφθονα δεν απαντώνται σε άλλη περιοχή της Ελλάδας και 

συνεπώς η διατήρησή τους έχει σημασία. Ως βολβόφυτα τα παραπάνω είδη μπορούν να 

επηρεαστούν αρνητικά από μεταπυρικές διαδικασίες αποκατάστασης με τη χρήση βαριών 

μηχανημάτων. 

 

Κεφάλαιο 4. 

Δειγματοληψία και αποτίμηση ακρίβειας 

Για την αποτίμηση της ακρίβειας  χρησιμοποιήθηκε δορυφορική εικόνα υψηλής ευκρίνειας  

που λήφθηκε μετά την φωτιά από τον δορυφόρο QuickBird με ακρίβεια 0,6μ., την οποία είχε  

προμηθευτεί  η υπηρεσία μου για την αποτίμηση των καμένων εκτάσεων. 

Ανοίγουμε και τα δύο αρχεία στο πρόγραμμα, στη συνέχεια επιλέγουμε την εντολή Window -

>Tile    Horizontally, αφού πρώτα τσεκάρουμε το   και το . Με αυτό τον τρόπο έχουμε 

τις δύο  εικόνες της πυρκαγιά στην επιφάνεια εργασίας. Μετακινώντας το κέρσορα επάνω στην 

πρώτη δορυφορική εικόνα, βλέπουμε σε τι αντιστοιχεί το σημείο αυτό στη δεύτερη δορυφορική 

εικόνα. Με τον τρόπο αυτό γίνεται η σύγκριση εάν το σημείο που επιλέχθηκε επηρεάστηκε από 

την  πυρκαγιά και με τη χρήση pixel info εάν κάηκε ή όχι.  

Όσον αφορά την αποτίμηση της συνολικής καμένης έκτασης, ακρίβεια προκύπτει και από την 

σύγκριση την αποτίμηση της καμένης έκτασης από την διπλωματική εργασία του Γ. 

Αναστασάκη με χρήση δορυφορικών εικόνων Landsat. 
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 Η καμένη έκταση σύμφωνα με την παραπάνω εργασία φαίνεται στην παρακάτω εικόνα 12 

και έχει  έκταση 45.900 στρέμματα, υπερεκτιμημένη κατά 7,8% σε σχέση με την υπολογισθείσα 

από την  παρούσα εργασία.  

Η χρήση εικόνων SENTINEL 2, διακριτικής ικανότητας 10μ. δίνει μικρότερα  αποτελέσματα 

λόγω μεγαλύτερης χωρικής ανάλυσης.  

Είναι δεδομένο ότι η χρήση εικόνων Landsat με χωρική ανάλυση 30μ. θα υπερεκτιμούσε το  

αποτέλεσμα, λόγω εισαγωγής στον υπολογισμό της καμένης έκτασης των οριακών pixels. 
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Εικόνα 12. Υπολογισμός καμένης έκτασης με χρήση εικόνας Landsat. 

(Πηγή: Αθανασάκης Γ. «Χαρτογράφηση της πυρκαγιάς της Χίου 2016,  με τη χρήση 

δορυφορικών εικόνων και γεωγραφικών πληροφοριακών συστημάτων», Μεταπτυχιακή διατριβή, 

Γεωπονικό Πανεπιστήμιο Αθηνών, Αθήνα 2018). 
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.  

Πηγή: (ΕΠαΔαΠ  Εθνικό  Παρατηρητήριο Δασικών πυρκαγιών). 

 

Υπολογισμός καμένης έκτασης από το Εθνικό Παρατηρητήριο Δασικών Πυρκαγιών και την 

WWF Ελλάς  με χρήση δορυφορικών δεδομένων SENTINEL 2 δίνουν καμένη έκταση 43.431 

και 43.469 αντίστοιχα, 4% μεγαλύτερη από αυτήν που υπολογίστηκε στην παρούσα εργασία. 

Το EFFIS δίνει καμένη έκταση 35.000 στρέμματα, υποεκτιμημένα κατά 21% επειδή 

χρησιμοποιεί δεδομένα από το σύστημα MODIS το οποίο έχει μικρή ακρίβεια. 

Στον παρακάτω πίνακα φαίνεται η ταξινόμηση της βλάστησης κατά την WWF Ελλάς. 

 

    

   ΣΥΝΟΛΟ                         43.469 στρέματα        (Πηγη: Μητσόπουλος κ.α. 2017) 
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Γενικά μπορούμε να πούμε ότι οι μεθοδοι που εφαρμόστηκαν  διαφέρουν περίπου κατά 10% 

στα αποτελέσματα. 

     Η σύγκριση με κλασικές μεθόδους καταγραφής δεν μπορεί να γίνει επειδή οι δασικές 

υπηρεσίες κατά την έκδοση των αποφάσεων κήρυξης αναδασωτέωμ εκτάσεων, δεν εξαιρούν 

τους άκαυτους θύλακες, με αποτέλεσμα οι έκταση που κάηκε να φαίνεται μεγαλύτερη.  
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Κεφάλαιο 6.  Συμβουλές  μεταπυρικής  διαχείρισης 

 

Η μεταπυρική διαχείρισης είναι κρίσιμο θέμα που απαιτεί βαθειά γνώση του προς διαχείριση 

αντικείμενου και σωστή στοχοθεσία. Στην προκειμένη περίπτωση η Χίος δεν θα μπορούσε να 

αποτελέσει εξαίρεση. Αρχικά, θεωρούμε σκόπιμο να αποφευχθεί μαζική συγκομιδή των 

καμένων κορμών. Αυτό γιατί τα καμένα εδάφη είναι πολύ ευαίσθητα και το πάτημα κατά τη 

διάρκεια της διαδικασίας κοπής προκαλεί συμπίεση. 

Η συμπίεση του εδάφους μπορεί να προκαλέσει απώλεια των κενών τμημάτων που υπάρχουν  

ανάμεσα στους εδαφικούς κόκκους, δηλαδή να εμποδίσει τον αερισμό του, αλλά και τη διέλευση 

του νερού στο έδαφος. Αυτό μπορεί να οδηγήσει σε επιφανειακή απορροή με πολύ σοβαρές 

συνέπειες. Εκτός τούτου, τα ιστάμενα δέντρα λειτουργούν ως ομπρέλες, οι οποίες περιορίζουν 

την κινητική δύναμη της βροχής, η οποία, περνώντας μέσα από το φύλλωμα ή κυλώντας κατά 

μήκος του καμένου κορμού πέφτει με μικρότερη δύναμη στο έδαφος. 

Επίσης, τα ιστάμενα δέντρα λειτουργούν προστατευτικά για τα νεαρά φυτάρια, ιδιαίτερα το 

καλοκαίρι όπου επικρατούν υψηλές θερμοκρασίες και οι ακτίνες του ηλίου πέφτουν κάθετα. Επί 

πλέον, το καμένο δάσος πολύ συχνά λειτουργεί ως πόλος έλξης πουλιών, πολλά από τα οποία 

φωλιάζουν στα καμένα κλαδιά. Αξίζει να αναφερθεί ακόμη πως συχνά ανοίγονται δρόμοι ειδικά 

για να μαζευτούν οι κομμένοι καμένοι κορμοί με όλες τις επακόλουθες συνέπειες. Ένας 

τελευταίος λόγος που θα μπορούσε να εμποδίσει τη μαζική απόληψη των καμένων δέντρων είναι 

πως οι ιστάμενοι καμένοι κορμοί ενδεχομένως αποτρέπουν επίδοξους καταπατητές της καμένης 

γης.  

Η απομάκρυνση ιστάμενων καμένων δένδρων θα πρέπει να είναι πολύ περιορισμένη και 

επιλεκτική και να πραγματοποιηθεί με ήπια μέσα. Η διατήρηση καμένων κορμών κρίνεται 

απαραίτητη για την προστασία του εδάφους από έντονα κατακρημνίσματα, συγκράτηση του 

εδάφους και δημιουργία καλύτερου μικροπεριβάλλοντος για την υποδοχή της νέας βλάστησης.  

 Ωστόσο, ο καμένος ξυλώδης όγκος δεν θα πρέπει να είναι τέτοιου μεγέθους και συγκόμωσης, 

ώστε να δημιουργεί επικίνδυνη καύσιμη ύλη για μελλοντικές πυρκαγιές. Όποιες εργασίες 

κριθούν απαραίτητες θα πρέπει να γίνουν με επίβλεψη της Δ/νσης Δασών, δίνοντας την 

απαραίτητη προσοχή στο εδαφικό κεφάλαιο και στην πιθανή παρουσία νέων αρτίβλαστων.   

(Ξανθόπουλος, 2001). 

Στα γαιώδη εδάφη με κλίσεις από 35-55% ενδείκνυνται η επιμελής κατασκευή 

κορμοδεμάτων. Τα κορμοδέματα δεν έχουν ουσιαστική επίδραση σε μικρότερες κλίσεις συνεπώς 
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είναι άσκοπη δαπάνη, ενώ σε μεγαλύτερες κλίσεις, λόγω της διατάραξης του εδάφους από τις 

εργασίες αυξάνονται οι κίνδυνοι διάβρωσης και είναι σκόπιμο να αποφεύγονται. Τα 

κλαδοπλεγμάτα δεν έχουν σημαντική επίδραση ούτε στην προστασία του εδάφους ούτε και στην 

επιφανειακή απορροή, γι’ αυτό δεν ενδείκνυνται να κατασκευαστούν. Πέραν των παραπάνω, 

είναι δυνατό να κατασκευαστούν λιθοφράγματα και κορμοφράγματα στα κύρια μικρορέματα και 

ειδικά φράγματα μόνο σε επιλεγμένες θέσεις. Σε όλα τα τεχνικά έργα, προς τα ανάντι 

δημιουργείται ευνοϊκότερο περιβάλλον για την εγκατάσταση ποικιλίας λιβαδικών ειδών. 

    Η κατασκευή και τοποθέτηση κορμοδεμάτων και κλαδοπλεγμάτων που χρησιμοποιούνται για 

την ανάσχεση των πλημμυρικών φαινομένων και τον έλεγχο της πιθανής διάβρωσης πρέπει να 

γίνεται επιλεκτικά και με μεγάλη προσοχή. Εδάφη που δεν έχουν σε μεγάλη κλίμακα κλίσεις 

μεγαλύτερες του 30% δεν εμφανίζουν διαβρώσεις, ενώ διαβρώσεις δεν εμφανίζουν και πετρώδη 

εδάφη.  

Επιπλέον προστασία των εδαφών προσφέρουν και τα πεσμένα φύλλα. Στην περίπτωση της 

Χίου, τόσο οι πεσμένες βελόνες των πεύκων όσο και αυτές που πρόκειται ενδεχομένως να 

πέσουν από τα καμένα δέντρα προσφέρουν στο έδαφος ένα προστατευτικό μανδύα έναντι της 

διαβρωτικής δράσης του νερού. Εμμέσως δηλαδή η φύση δημιουργεί αυτό που οι διαχειριστές 

ονομάζουν «mulching» και εφαρμόζουν για την προστασία των εδαφών. Το «mulching» είναι η 

διαδικασία κατά την οποία το φυτικό υλικό «τρίβεται» και απλώνεται ως προστατευτικό 

κάλυμμα στο καμένο έδαφος για να εμποδίσει τη διάβρωσή του. 

    Τέλος, αυτά θα συμβούν υπό την προϋπόθεση ότι δεν έχουμε κάποια άλλη επέμβαση, δηλαδή 

δεν έχουμε βόσκηση – που συνιστά μια μεγάλη απειλή στην πορεία της αναγέννησης ή δεν 

έχουμε μιαν άλλη φωτιά. Τα ζώα που βόσκουν προκαλούν αφενός μεν απευθείας συμπίεση των 

εδαφών και καταστροφή της δομής τους, ενώ τρώγοντας τα νεαρά αναβλαστήματα ή αρτίβλαστα 

μπλοκάρουν τη διαδικασία της αποκατάστασης της πρωτογενούς παραγωγής οδηγώντας 

σταδιακά σε υποβάθμιση της περιοχής, κατάσταση που καταγράφεται εκτεταμένα στη Βόρεια 

Χίο. 

Σχετικά με τις ενδεχόμενες αναδασώσεις σε αυτή τη φάση η πρόταση είναι να μην προβεί 

κανένας φορέας σε καμιά ενέργεια μέχρι να δούμε με λεπτομέρεια τη δυνατότητα φυσικής 

αναγέννησης. (WWF Ελλάς, 2012). 
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Κεφάλαιο 7.  Προτάσεις-Συνπεράσματα. 

7.1 Προτάσεις. 

Η έγκαιρη αντιμετώπιση όλων των παραπάνω ζητημάτων σε συνδυασμό με έναν γενικότερο 

σχεδιασμό μεταπυρικής αποκατάστασης και μελλοντικής προστασίας του φυσικού πλούτου της 

Χίου είναι το στοίχημα που πρέπει να κερδηθεί και βρίσκεται στο χέρι των τοπικών φορέων.  

Επιβεβλημένο είναι όλοι οι υπεύθυνοι φορείς σε συνδυασμό με την τοπική κοινωνία, τους 

επαγγελματίες που δραστηριοποιούνται στη περιοχή (αγρότες, κτηνοτρόφοι, κ.α.), ενεργοί 

πολίτες και σωματεία να συμβάλλουν στην επίτευξη των παρακάτω: 

 Να συμμετέχουν και να συμφωνήσουν σε έναν ενιαίο σχεδιασμό για τη διαχείριση και 

προστασία του φυσικού τους περιβάλλοντος. 

 Οι αποφάσεις και οι επιμέρους εργασίες, πρέπει να σχεδιαστούν και υλοποιηθούν με τη 

βοήθεια ειδικών επιστημόνων, που θα συμβάλλουν με εξειδικευμένη γνώση στην ορθή και 

ολοκληρωμένη   αντιμετώπιση των προβλημάτων. 

 Σημαντικό είναι ο Δήμος Χίου, ως ο κύριος δασοκτήμονας της περιοχής να διαθέτει 

ειδικό επιστημονικό προσωπικό, που θα αναλάβει το γενικότερο συντονισμό και τις δράσεις που 

αφορούν τις δημοτικές δασικές εκτάσεις. Φυσικά, αναγκαία προϋπόθεση είναι και η εξασφάλιση 

της απαραίτητης χρηματοδότησης από την πολιτεία και η εξεύρεση πόρων από φορείς και 

ιδιώτες. 

  Η συμβολή του τοπικού πληθυσμού στις διάφορες δράσεις, η ενεργοποίηση των πολιτών 

και η γενικότερη ενημέρωση-ευαισθητοποίηση των κατοίκων της Χίου είναι ίσως από τους πιο 

σημαντικούς στόχους στους οποίους πρέπει να προσβλέπει ένας ολοκληρωμένος σχεδιασμός. 

 Αποτύπωση των εκτάσεων που ιδιοκτησιακά ανήκουν στο Δήμο Χίου προκειμένου αυτός 

να αναλάβει δράσεις που ανήκουν στις αρμοδιότητές του. 

 Ολοκλήρωση της εκπόνηση και κύρωση δασικών χαρτών, τα οποία αποτελούν 

απαραίτητα εργαλεία για τη σύγχρονη διαχείριση του χώρου και των διάφορων δραστηριοτήτων. 

 Να ολοκληρωθεί και να εφαρμοστεί στην πράξη ο αντιπυρικός σχεδιασμός για ολόκληρο 

το νησί σε συνεργασία όλων των φορέων που εμπλέκονται.  
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7.2 Συμπεράσματα. 

Ειδικά συμπέρασματα για την πυρκαγιά της νήσου Χίου 

Η μεγάλη πυρκαγιά της Χίου της 25-7-2016 είναι από τις μεγαλύτερες που έπληξαν ποτέ το 

νησί, καθώς άφησε πίσω της χιλιάδες καμένα στρέμματα δάσους τραχείας πεύκης, δασικών 

εκτάσεων, φρυγανικά - χορτολιβαδικά οικοσυστήματα και γεωργικές εκτάσεις που αποτελούνται 

κυρίως από μαστιχόδεντρα και ελαιώνες. 

Το έντονο ανάγλυφο του νησιού, κυρίως στο βόρειο τμήμα της καμένης έκτασης, η παρουσία 

ασβεστολιθικών πετρωμάτων, σχεδόν στο σύνολο της έκτασης, η ύπαρξη μεγάλων εκτάσεων 

βοσκοτόπων και το γεγονός ότι το νησί έχει ξανακαεί στο παρελθόν, δημιουργούν κινδύνους για 

περιβαλλοντικά προβλήματα, όπως οι διαβρώσεις των εδαφών και πλημμύρες. Τα δυο αυτά 

φαινόμενα μπορούν να συντελέσουν στην απογύμνωση του τοπίου αλλά και στην αδυναμία 

αναγέννησης της βλάστησης. 

Η χρήση του δείκτη NBR υποδεικνύει τις θέσεις που έχουν μεγαλύτερο κίνδυνο από 

διάβρωση και πλημμύρες. Περιοχές με τιμές που πλησιάζουν το +1 είναι οι επικίνδυνες για 

πλημμυρικά φαινόμενα.Σε αυτές τις περιοχές είναι επιτακτική ανάγκη πραγματοποίησης 

αντιδιαβρωτικών και αντιπλημμυρικών έργων Αυτές οι περιοχές φαίνονται στον ασπρόμαυρο 

χάρτη ποιο σκοτεινές και στο G.I.S. με άλλα χρώματα. Σε αυτές τις περιοχές ιδαίτερη έμφαση 

πρέπει να δοθεί στις περιοχές που έχουν διπλοκαεί.  

Η χρήση του δείκτη dNDVI = preNDVI-postNDVI και η σύγκριση των διαφορών τους με 

δορυφορική εικόνα λίγα χρόνια μετά την πυρκαγιά, υποδεικνύει τις θέσεις που απέτυχε η 

αναγέννηση και απαιτείται τεχνητή αναδάσωση (Petropoulos 2018 Remote sensing in biomass 

burning). 

Για τις περιοχές που έχουν καεί περισσότερο από μία φορά απαιτείται η λήψη 

πρόσθετων  μέτρων, προκειμένου να αποφευχθεί το φανόμενο της ερημοποίησης. 

 Για τις περιοχές που οι δείκτες δριμύτητας καύσης είναι μεγάλοι θα πρέπει να 

κατασκευαστουν  αντιδιαβρωτικά-αντιπλημμυρικά έργα. Για αυτό και μόνο το λόγο φαίνεται η 

χρησιμότητα των δορυφορικών εικόνων, επειδή σε πολύ σύντομο διάστημα έχουμε μετρήσεις 

και το τι μέλεστε γενέσθαι. 

Διαχρονικά οι πυρκαγιές της Χίου φαίνονται στους παρακάτω χάρτες (εικόνα 13 και 14). 

(Πηγή « WWF Ελλάς, 2016 για τον χάρτη 13 και Γ.Αθανασάκης για την εικόνα 14). 
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Εικόνα 13 Οι μεγάλες πυρκαγιές της Νήσου Χίου μετά το έτος 2000. 
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Εικόνα 14. Χάρτης Google Earth με την διπλοκαμένη περιοχή από τις πυρκαγιές 2012-2016. 

 

Οι οικολογικές και περιβαλλοντικές επιπτώσεις των πυρκαγιών στα δάση παρουσιάζονται με 

την υποβάθμιση της ποιότητας της βλάστησης, τη μείωση της βιοποικιλότητας, την καταστροφή 

της υγιεινής των οικοσυστημάτων, την απώλεια της άγριας ζωής, την ατμοσφαιρική ρύπανση, τη 

μόλυνση των υδάτων και γενικά την οικολογική υποβάθμιση. Στις πυρκαγιές λοιπόν αποδίδεται 

η μείωση των δασών και η επιτάχυνση της υποβάθμισης του εδάφους και της ερημοποίησης.   

  Έπειτα από πυρκαγιές σχετικά μικρής καταστροφικότητας, η ανανέωση του δάσους μπορεί 

να διαρκέσει μόνο όσο θα χρειαστεί η χλωρίδα και η πανίδα του εδάφους να αποκατασταθεί και 

να συσσωρευτεί  η επιφανειακή οργανική ύλη. Οι αλλαγές, ιδιαίτερα η απώλεια της οργανικής 

ύλης από το έδαφος και υπέδαφος επηρεάζουν την χημική και φυσική κατάσταση του δασικού 

εδάφους η οποία  επηρεάζει την επακόλουθη αναγέννηση του δάσους, τη συγκράτηση του νερού  

και την απώλεια του εδάφους με τη διάβρωση.  

Έπειτα από πυρκαγιές μεγάλης καταστροφικότητας η αυξημένη επιφανειακή απορροή κατά 

τη διάρκεια καταιγίδων ευνοεί τη διάβρωση και τις μικρές κατολισθήσεις, ειδικά σε θέσεις όπου 
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οι ρίζες και άλλα οργανικά υλικά που συγκρατούν το χαλαρό έδαφος στις πλαγιές έχουν 

καταστραφεί. Οι μεγάλες πυρκαγιές προκαλούν μεγαλύτερους  κινδύνους διάβρωσης έως ότου 

αρχίσει να επανέρχεται η φυτοκάλυψη και να συσσωρεύονται πάλι  οργανικά υπολείμματα στην 

επιφάνεια του εδάφους.  Στις πλαγιές όπου η φυτοκάλυψη είναι ελάχιστη και μετά την πυρκαγιά 

έχουν συγκεντρωθεί φερτά υλικά, τότε το έδαφος μπορεί να διαβρωθεί ακόμη και χωρίς έντονες 

βροχές, εξαιτίας της δύναμης της βαρύτητας.  

  Η παραπάνω περιοχή έχει επλήγη 2  φορές, την πρώτη από την μεγάλη καταστροφική 

πυρκαγιά του 2012 και την δεύτερη από προσφάτως  από την πυρκαγιά του 2016 στα 

Μαστιχοχώρια. 

 Η περιοχή αξίζει να διερευνηθεί στο μέλλον για τυχόν διάβρωση του εδάφους (ερημοποίηση) 

καθώς η περιοχή  αποτελείται κατά κύριο λόγω από ανθρακικά πετρώματα όπου είναι ευάλωτα 

στην διάβρωση από τους εξωτερικούς περιβαλλοντικούς παράγοντες που επικρατούν στην 

περιοχή καθώς το νησί της Χίου είναι σε υψηλό βαθμό ερημοποίησης λόγω των εκτεταμένων 

πυρκαγιών κάθε καλοκαιρινή περίοδο και λόγο της αποψίλωσης των δασών κατά το παρελθόν 

(παράνομη υλοτομία κλπ). 

2) Γενικά συμπεράσματα 

Οι δορυφορικές εικόνες είναι πολύ χρήσιμες για την ταχεία αποτύπωση των φυσικών πόρων 

μια περιοχής και την αποτίμηση της καμένης έκτασης. Δεν απαιτείται η μετάβαση στην περιοχή 

και η χρήση GPS για την χαρτογράφηση. Άμεση εξαγωγή συμπερασμάτων για την λήψη 

αποφάσεων  από τα αρμόδια  όργανα,  για την  άμεση λήψη μέτρων για την προστασία και μη 

υποβάθμιση του περιβάλλοντος. Μπορούν  να βοηθήσουν στην εκπόνηση σχεδίων διαχείρισης 

φυσικών πόρων, του περιβάλλοντος  γενικά και στον σχεδιασμό των διάφορων έργων. 

    Η προμήθεια των δορυφορικών δεδομένων SENTINEL και LANDSAT είναι  πολύ εύκολη    

και δωρεάν. Απαιτείται μόνο εγγραφή στον αντίστοιχο  οργανισμό.  Υπάρχει βάση δεδομένων    

από τις αρχές του έτους 1980 έως σήμερα.  Το κόστος αγοράς των δορυφορικών δεδομένων    

υψηλής ανάλυσης  (<5μ.) έχει  πλέον  μειωθεί και είναι εύκολη η προμήθειά τους ακόμα και από    

φοιτητές. 

Τα ελεύθερο λογισμικό SNAP της esa κρίνεται ικανό και αρκετό  για τις περισσότερες 

περιπτώσεις στην επεξεργασία των δορυφορικών εικόνων. Τα αποτελέσματα που εξάγονται από 

αυτό επεξεργάζονται από άλλα λογισμικά G.I.S. ελεύθερα ή μη.  

Η Δασική Υπηρεσία θα βοηθηθεί στην άμεση λήψη αποφάσεων για την διαχείριση και 

προστασία της έκτασης, εάν αξιοποιήσει τα δορυφορικά δεδομένα. 
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Η αξιοπιστία της μεθόδου περιορίζεται από την ταξινόμηση της βλάστησης που πρέπει να 

γίνει σε ενευθέτω χρόνο για όλες τις περιοχές της χώρας. Η ταξινόμηση με το corine δεν δίνει 

ικανοποιητικά αποτελέσματα όπως δείχνει η σύγκριση με τους χάρτες βλάστησης του ΥΠΕΝ. 

 

 

Η συνεργασία και ο συνδυασμός της Τηλεπισκόπησης και των Γεωγραφικών    

Πληροφοριακών Συστημάτων έχει καταστεί πολύ χρήσιμος  και βοηθά  στην: 

 Ακριβή και γρήγορη ανάδειξη της καμένης έκτασης  

 Καταγραφή των  επιπτώσεων μετά από μια πυρκαγιά 

 Διερεύνηση των αλλαγών στη χρήση / κάλυψη γης πριν και μετά από μια πυρκαγιά 

 Την παρακολούθηση του ρυθμού αναγέννησης της βλάστησης  

 Τον σχεδιασμός έργων πρόληψης πιθανής εκδήλωσης πυρκαγιάς. 

 Την πρόληψη & παρακολούθηση μεταπυρικών κινδύνων (Πλημμύρες, Κατολισθήσεις) 
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 http://www.satimagingcorp.com/satellite-sensors/quickbird.html 

 http://www.satimagingcorp.com/satellite-sensors/geoeye-1.html 

 https://earth.esa.int/web/guest/missions/3rd-party-missions/potential- missions/quickbird-2 
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